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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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CORPORATE PROFILE
Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size, intrusion porosimetry, powder rheology, and activity testing
of catalysts. The company has R&D and manufacturing sites in the USA, UK, and Spain, and
direct sales and service operations throughout the Americas, Europe, and Asia. Micromeritics
systems are the instruments-of-choice in more than 10,000 laboratories of the world’s most
innovative companies and prestigious government and academic institutions. Our world-class
scientists and responsive support teams enable customer success by applying Micromeritics
technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International: Contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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About this Manual

ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.Micromeritics.com).

n Calculations document (PDF)
n Error Messages document (PDF)
n Operator Manual (PDF)

n Parts and Accessories

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage the
analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.

KEYPAD FUNCTION—The keypad icon indicates the section is applicable only
when using the keypad.

NOTE — Notes that apply to 21CFR11 environments only (Confirm applications).
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GENERAL SAFETY

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

Any piece of laboratory equipment can become dangerous to personnel when improperly
operated or poorly maintained. All employees operating and maintaining Micromeritics
instruments should be familiar with its operation and should be thoroughly trained and instructed
on safety.

n Read the operator manual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Wear the appropriate personal protective equipment when operating this
instrument — such as eye protection, lab coat, protective gloves, etc.

n When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The AccuPyc 1345 weighs approximately 7.9 - 26 kg (17 -
51 lb) depending on configuration. The AccuPyc 1350 weighs approximately 11.5
kg (25.3 lb).

n Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not become worn or damaged.

n The AccuPyc 1350 sound level is <65dBA from the operator's normal position, and
approximately 75dBA at 20 cm from the back of the instrument. Hearing protection
is optional.

n The AccuPyc II sound level is below 80 dBA. Hearing protection is optional.
n Proper maintenance is critical to personnel safety and smooth instrument

operation and performance. Instruments require regular maintenance to help
promote safety, provide an optimum end test result, and to prevent costly down
time. Failure to practice proper maintenance procedures can lead to unsafe
conditions and shorten the life of the instrument.

n Improper handling, disposing of, or transporting potentially hazardous materials
can cause serious bodily harm or damage to the instrument. Always refer to the
MSDS when handling hazardous materials. Safe operation and handling of the
instrument, supplies, and accessories is the responsibility of the operator.

General Safety
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General Safety

INTENDED USE
The AccuPyc Series Pycnometers are fast, fully automatic pycnometers that provide high-speed,
high-precision volume measurements and true density calculations on a wide variety of powders,
solids, and slurries. After analyses are started with a few keystrokes, data are collected,
calculations are performed, and results displayed. A minimal amount of operator attention is
required.

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer and as well as
relevant hazards involved and prevention methods. Other than what is described in
this manual, all use is seen as unintended use and can cause a safety hazard.

The instrument is intended to be used as per applicable local and national regulations.

TRAINING
It is the customer's responsibility to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.

ENVIRONMENTALLY FRIENDLY USE PERIOD

Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Cover x o o o o o

Power
Supplies x o o o o o

Printed
Circuit
Boards

x o o o o o

Cables, Con-
nectors &
Transducers

x o o o o o

Hazardous Substances Table
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o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Cover o o o o o o

Power
Supplies o o o o o o

Printed
Circuit
Boards

o o o o o o

Cables, Con-
nectors &
Transducers

x o o o o o

Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product
manual.

General Safety
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General Safety

SYMBOLS THAT MAY APPEAR ON YOUR INSTRUMENT

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear on your instrument:

Use extreme caution when working on the instrument where one of these symbols
may be displayed. These symbols indicate the part may be hot and cause serious
burns.

Use the cotton gloves provided in the accessory when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

When working on the instrument where this symbol is displayed, refer to your Micro-
meritics' instruction manual for additional information.

When this symbol is displayed, toxic or flammable gases require proper venting of
exhaust.

This symbol can also indicate the instrument uses mercury which is an extremely
toxic substance. Read the Material Safety Data Sheet (MSDS) and be aware of the
hazards of mercury and know what to do in the event of a spill or an exposure
incident
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1 ABOUT THE ACCUPYC II

Gas pycnometry is recognized as one of the most reliable techniques for obtaining true, absolute,
skeletal, and apparent volume and density. This technique is non-destructive as it uses the gas
displacement method to measure volume. Inert gases, such as helium or nitrogen, are used as
the displacement medium. Density calculations using the gas displacement method are much
more accurate and reproducible than the traditional Archimedes water displacement method.

The AccuPyc II Pycnometers are fast, fully automatic pycnometers that provide high-speed, high-
precision volume measurements and true density calculations on a wide variety of powders,
solids, and slurries. The instrument completes most sample analyses in less than three minutes
without sacrificing accuracy. After analyses are started with a few keystrokes, data are collected,
calculations are performed, and results displayed. A minimal amount of operator attention is
required.

The pycnometer can be controlled by either:

n Windows 10 interface. The operational status of the pycnometer can be continually monitored
in the application. If the Windows interface is used, the keypad is disabled.

n The keypad if not running the Windows interface. A separate keyboard and printer can be
attached to the pycnometer using USB ports.

1 About the AccuPyc II
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1 About the AccuPyc II

INSTRUMENT COMPONENTS

FRONT COMPONENTS

The sample chamber, located on the top panel, is where the sample cup is placed for analysis.

The sample chamber should remain capped except when inserting or removing a sample. When
left uncapped, water vapor adsorbs on the inner surface of the chamber or the chamber
temperature becomes unstable; either condition can affect analysis results. If water vapor
accumulates in the chamber, the pycnometer must be purged.

The standalone control module, often used for the Glove Box pycnometer, does not contain a
sample chamber. SeeGlove Box on page 1 - 9.

Component Description
A Active indicator A blue LED which illuminates when an operation is in progress.

It is included on all analysis modules. It is not included on stan-
dalone control modules.

B Power indicator A green LED which illuminates when the analyzer is powered
on.

C Sample chamber For inserting sample material.

D Keypad For operating the pycnometer without the Windows applic-
ation.

E Display window Displays Remote Operation when the Windows application is
being used.
The AccuPyc can be operated in the keypad mode when the
Windows application is closed.

Front Components
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BACK COMPONENTS

Component Description
Dust filter (not shown) (For 2000 cm3 units and high pressure units only.)

Traps sample dust to protect internal valves.
A RS-232 port transmit data only when using the keypad function.

Also used to connect to the analytical balance.
B USB connectors Use for connecting a keyboard, printer, or balance to

the instrument.
C Ethernet port Provides for setting up for e-mailing reports, sending

data to a web browser, or interfacing with the
AccuPyc Windows application.

D Brightness control adjust the brightness of the display. See Brightness
Control on page 11 - 4.

E Analysis module connector connect up to five analysis modules to the initial con-
trol / analysis module. Each module contains analysis
module input and output connectors.

F Gas inlet port Use to connect the analysis gas; helium is recom-
mended. If multiple analysis modules are attached,
each module contains a gas inlet port. Multiple gases
can be attached using the Multigas option. SeeMulti-
gas Option on page 16 - 1.

G ON/OFF switch For powering the analyzer on and off.

H Power connector For connecting the power source to the instrument
using a mini-DIN cable.

Back Components

Instrument Components
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1 About the AccuPyc II

ABOUT THE TEC MODULE

TEC Module on page 13 - 1

Density measurements at specific temperatures are required for certain applications. The
AccuPyc II Thermo Electric Cooling (TEC) Module maintains an accurate temperature control
during analysis using the principle of Peltier cooling.

TECModules, also known as Peltier coolers, are solid-state heat pumps that utilize the Peltier
effect to move heat. By passing a current through the TECModule, heat is transferred from one
side of the module to the other, typically producing a heat differential of approximately 40° C.

The transferred heat is then removed from the system through the combination of a heat sink and
fan, cooling the system to maintain a set temperature for accurate analysis.

TEC systems feature:

n fast dynamic response
n long-life
n no moving parts
n no use of refrigerants or circulated liquids / antifreeze

1 - 4 AccuPyc II 1345 Operator Manual
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ASPHALT DENSITY APPLICATION

The AccuPyc II TEC Module can measure asphalt density using disposable cups to limit cross-
contamination of samples. To show cup properties and asphalt options, go toOptions > Option
Presentation and enable Show Cup Properties and Show Asphalt Options.

This solution can be closely correlated (< 0.15% difference) to results obtained with ASTM Test
Method D70-09. The AccuPyc asphalt density measurement is completed much faster than the
ASTMmethod while virtually eliminating operator error. The Peltier thermoelectric cooling control
(15 to 36 °C) provides stability for handling of samples.

ABOUT THE FOAMPYC MODULE

A FoamPyc option for measuring open and closed cell foammaterials is available for both
standard and temperature-controlled pycnometers. This unit can be ordered initially with the
FoamPyc application installed, or can be upgraded from the standard AccuPyc with a software
enhancement via USB media. Configuration options are:

n 100 cm3 nominal cell volume (recommended)
n 10 cm3 nominal cell volume

The FoamPyc option performs analyses on materials such as polystyrene, urethane, and rubber
foams using five different methods:

n Correction using cell dimensions.Measures the closed cell fraction and corrects for the
cells damaged while cutting the sample to the necessary size and shape. This is accomplished
by using either the average cell diameter or the cell chord length (as defined in ASTMmethod
D-6226-15) and the measurements of the sample to determine the volume of the cut cells. This
volume is deducted from the total volume of the open cells measured by the pycnometer.

n Correction by recutting sample. Corrects for the cut cells by using two separate meas-
urements. For the 2nd measurement, the sample is recut to double the amount of cut surface.
The observed difference in cut open cell volume is applied as a correction to the initial meas-
ured volume. This method offers the distinct advantage that no assumptions are needed about
the relative amounts of open and closed cells.

n No correction. Does not correct for cut cells. It is used for materials with predominantly open
cells where good accuracy can be achieved without correction. The accuracy level deteriorates
as the percentage of closed cells increases.

n Compressibility test. The fill pressure is increased incrementally over the sample with each
repeat of the P1, P2 cycle (where P1 is the initial pressure to which the sample is charged, and
P2 the final pressure after expansion). The apparent variation of the measured sample volume
with the average pressure is determined. This test is an approximate indication. It is not inten-
ded to be an exact measure of the volume compressibility.

n Cell fracture test. A perfectly rigid foam is assumed. First, a P1, P2 cycle is performed at the
lower of two specified P1 pressures, and the results stored. A second cycle is performed at a

Asphalt Density Application
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1 About the AccuPyc II

higher specified value of P1, then a third cycle identical to the first cycle is performed. The dif-
ference between the volume of the sample on the first measurement and on the third meas-
urement is reported as the volume of fractured cells. It is assumed that cells fracture by
exposure to the highest pressure (2nd cycle) so that when the third measurement is made, the
measured sample volume has decreased from the first cycle by the amount of the closed cell
volume which was fractured.

The 100 cm3 AccuPyc II has been designed and tested to follow the procedure in ASTMMethod
D 6226 for FoamPyc analyses. The 10 cm3 and 350 cm3 units can be used for some types of foam
materials; however, analyses on these AccuPycs will not conform to the ASTMmethod. The 1
cm3 AccuPyc II cannot be used to perform FoamPyc analyses.

The FoamPyc software also provides the capability to perform analyses in the Standardmode of
operation. This is especially convenient for users who have upgraded to the FoamPyc method
from the standard method. For example, a 100 cm3 AccuPyc on which FoamPyc analyses are
performed and a 1 cm3 analysis module attached on which standard analyses are performed.
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EQUIPMENT OPTIONS AND UPGRADES

Parts and accessories are located on the Micromeritics web page.

HIGH PRESSURE PYCNOMETER
Gas pycnometry is recognized as one of the most reliable techniques for obtaining skeletal
volume and density. The fully automatic AccuPyc High Pressure pycnometer provides high
speed, high precision volume measurements and density determinations on intact or crushed
shale core samples.

The high pressure pycnometer:

n Operates at a pressure of up to 500 psi to provide a better diffusion of the gas into the rock.
n Has a stainless steel sample chamber with a volume of 100 cm3.
n Has a sample chamber that can accommodate a 48 mm (1.85 in.) diameter core of up to 60 mm

(2.40 in.) in length.

LARGE VOLUME PYCNOMETER
The AccuPyc Large Volume pycnometer sample chamber addresses the specific needs of
operations that require pore volume knowledge of intact drilling cores. This instrument eliminates
the need to break core samples into smaller pieces prior to analysis.

The large volume pycnometer:

n Has a large sample chamber with a volume of approximately 2000 cm3.
n Has a sample chamber that can accommodate a 95 mm (3.74 in.) diameter core of up to 278

mm (10.9 in.) in length.

Equipment Options and Upgrades
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1 About the AccuPyc II

MULTIVOLUME INSERTS
The MultiVolume option is used to analyze smaller sized samples. Options are:

n 1 cm3 nominal cell volume; contains a 0.1 cm3 cup
n 10 cm3 nominal cell volume; contains 1 cm3 and a 3.5 cm3 cups
n 100 cm3 nominal cell volume; contains 10 cm3 and 35 cm3 cups
n 2000 cm3 nominal cell volume, contains 650 cm3 and 1300 cm3 cups

Each kit includes inserts, reference standards, and sample cups.

MULTIGAS OPTION

The Multigas Option allows connection of up to four gases to one analyzer. SeeMultigas Option
on page 16 - 1.

CONFIGURATION OPTIONS

For best fit with a sample, the AccuPyc II is available in multiple configurations.

All sample chamber volumes are nominal unless otherwise specified.

n 1 cm3 sample chamber
n 10 cm3 sample chamber
n 100 cm3 sample chamber
n 350 cm3 sample chamber
n 2000 cm3 sample chamber
n 100 cm3 high pressure sample chamber

Best fit means the sample nearly fills the sample chamber and, therefore, optimizes the precision
of the results.
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GLOVE BOX
Provides for analysis of samples in which a controlled environment is required.

Options Description
Configuration n 1 cm3 sample chamber

n 10 cm3 sample chamber
n 100 cm3 sample chamber
n 350 cm3 sample chamber
n 2000 cm3 sample chamber
n 100 cm3 high pressure sample chamber

This unit consists of two separate modules. The controller is placed outside the glove box, while
the analysis module is placed inside the glove box. Up to six analysis modules may be placed in
the glove box, all controlled by one external control module.

TEMPERATURE CONTROLLED MODULE

Provides for the attachment of an external circulating bath.

Options Description
Configuration n 10 cm3 sample chamber

n 100 cm3 sample chamber

The temperature controlled unit is specifically designed for temperature sensitive materials. This
unit is ideally suited for laboratories in which ambient temperature varies during normal work
hours, or in which subambient cooling is required.

TEC MODULE

About the TEC Module on page 1 - 4
Specifications for AccuPyc II TEC on page 1 - 16
TEC Module on page 13 - 1

Configuration Options
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1 About the AccuPyc II

GAS REQUIREMENTS

n Guidelines for Connecting Gases on page 12 - 12

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the MSDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Toxic, corrosive, flammable, poisonous, or injurious gases should not be used with the
AccuPyc.

The pycnometer uses helium or nitrogen (99.995% pure or better) to provide rapid, accurate
analyses. The cylinder containing helium must be fitted with a gas regulator set for 19-23 psig
(131-159 kPag). The pressure input to the pycnometer should never be greater than 22 psig (152
kPag). Excessive pressures waste gas due to a protection device contained in the pycnometer
that vents the pycnometer to atmospheric pressure if pressure exceeds 35 psig (241 kPag). This
protection device is not installed on 2000 cm3 or high pressure units.

n The High Pressure sample chamber configuration inlet pressure should never be
greater than 520 psig (3580 kPag); there is no pressure relief valve.

n Tank pressure should be at least 200 psi above regulator pressure.

Other inert, dry gases can also be used and may be more applicable for some applications.

1 - 10 AccuPyc II 1345 Operator Manual
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SPECIFICATIONS FOR ACCUPYC II 

Temperature

Stable between 15 to 35 °C (59 to 96 °F).

Temperature-controlled AccuPyc: temperature stability is dependent
upon specifications of the installed circulator.
Recommended range: 15 to 50 °C (59 to 122 °F).

Humidity 20 to 80% relative (non-condensing)

Indoor or Outdoor Use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax (6500 ft)
Pollution degree of the intended environment: 2

Operating Pressure 152 kPa (22 psi) max

Degree of Ingress
Protection IPX0

Environment

Temperature

Stable between 10 to 35 °C (50 to 96 °F).

Temperature-controlled AccuPyc: temperature stability is dependent
upon specifications of the installed circulator.
Recommended range: 15 to 50 °C (59 to 122 °F).

Temperature change: up to 2 °C per hour.

Humidity 10 to 80% relative (non-condensing) for laboratory temperature from
10 to 25 °C, maximum RH decreasing linearly to 50% at 35 °C.

Indoor or Outdoor Use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax (6500 ft)
Pollution degree of the intended environment: 2

Operating Pressure 152 kPa (22 psi) max

Degree of Ingress
Protection IPX0

Environment

Specifications for AccuPyc II 
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1 About the AccuPyc II

Analysis Module
(1, 10, 100 cm3)

Height: 20 cm (7.9 in.)

Width: 22.2 cm (8.7 in.)

Depth: 36.2 cm (14.3 in.)

Weight: 7.9 kg (17.4 lbs)

Weight: 8.2 kg (18.1 lbs), high pressure unit

Analysis Module
(350 cm3)

Height: 25.9 cm (10.2 in.)

Width: 22.2 cm (8.7 in.)

Depth: 36.2 cm (14.3 in.)

Weight: 10.5 kg (23.2 lbs)

Analysis Module
(2000 cm3)

Height: 43 cm (17 in.)

Width: 27 cm (10.6 in.)

Depth: 36.2 cm (14.3 in.)

Weight: 26 kg (57 lbs)

Control Module Height: 14.6 cm (5.8 in.)

Width: 27.3 cm (10.7 in.)

Depth: 36.2 cm (14.3 in.)

Weight: 3.6 kg (8 lbs)

Control Analysis
Module

Height: 20 cm (7.9 in.)

Width: 27.3 cm (10.7 in.)

Depth: 36.2 cm (14.3 in.)

Weight: 9.3 kg (20.5 lbs)

500 PSI Module
(100 cm3)

Height: 20.5 cm (8.1 in.)

Width: 22 cm (8.7 in.)

Depth: 38 cm (15 in.)

Weight: 14.5 kg (32 lbs)

Physical

1 - 12 AccuPyc II 1345 Operator Manual
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Voltage 90-264V~

Power 30 VA

Frequency 50/60 Hz

External Power
Adapter Manufacturer TRUMPower

Part Number TSA42-D21 (R1)

Pin 1, 2 Common return

Pin 3 +5V

Pin 4 N/C

Pin 5 12V

Shell N/C

Electrical

Specifications for AccuPyc II 
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1 About the AccuPyc II

Research grade helium is recommended. If unavailable, use helium with a dew point of -67 °C
(-88 °F) or lower. Carbon dioxide, argon, dry air, or nitrogen can also be used for different applic-
ations (a multigas option is available for connection of multiple gases).

Gases

1 cm3 chamber 1.14 cm ID × 1.1 cm D (0.45 in. ID × 0.44 in. D)

10 cm3 chamber 1.85 cm ID × 3.95 cm D (0.72 in. ID × 1.55 in. D)

100 cm3 chamber 4.62 cm ID × 6.18 cm D (1.82 in. ID × 2.43 in. D)

350 cm3 chamber 5.84 cm ID× 13.94 cm D (2.30 in. ID × 5.49 in. D)

2000 cm3 chamber 9.52 cm ID × 26.00 cm D (3.80 in. ID × 10.20 in. D)

Sample Cups

Precision

Reproducibility is typically to within ±0.01% of the nominal full-
scale sample chamber volume.

Reproducibility is guaranteed to within ±0.02% of the nominal full-
scale volume on clean, dry, thermally equilibrated samples using
helium in the 15 to 35 °C range.

Accuracy Accurate to within 0.03% of reading, plus 0.03% of sample capacity

Gas Consumption

Approximately 0.1 cm³ STP times the nominal cell volume for
each cycle

Approximately 2 cm³ STP times the nominal cell volume per ana-
lysis

Analysis
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A computer is not required if the keypad/display is used. When used in this configuration, data
can be sent to a USB equipped printer.

Operating System
Windows 10 or higher operating system is required. For 21 CFR
Part 11 environments, Windows 10 Professional or Windows 10
Enterprise or higher is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Ensure the "Sleep" setting on the desktop is set to
"Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection
is not successful.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required.

Read/Write Permissions

All application users will need Read/Write permission to all
directories and subdirectories where the application is installed.
For 21 CFR Part 11 environments, permission may be limited to
the installation directory.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.

Specifications for AccuPyc II 
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1 About the AccuPyc II

SPECIFICATIONS FOR ACCUPYC II TEC

Range 15 to 36 °C, (±0.1 °C)

Control Adjustable in 0.1 °C increments

Environment Stable between 15 to 35 °C (59 to 95 °F)
20% to 80% relative humidity

Indoor/Outdoor Use
Indoor only
Altitude: < 2000 m
Pollution degree of the intended environment: 2

Temperature Control

Height 28 cm (11 in.)

Width 28.7 cm (11.3 in.)

Depth 36.1 cm (14.2 in.)

Weight 13.8 kg (30.5 lbs)

Physical

Voltage 90-264V~

Power 100 VA (TEC)
30 VA (Electronics)

Frequency 50/60 Hz

Electrical

10 cm³ chamber 1.85 cm ID × 3.95 cm D
(0.72 in. ID × 1.55 in. D)

100 cm³ chamber 4.62 cm ID × 6.18 cm D
(1.82 in. ID × 2.43 in. D)

Sample Cups
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2 DATA ENTRY WITH KEYPAD

Use these instructions for keypad installations only. If a computer is attached to the
module, skip this section. All setup functions will be done in the analysis software.

For instructions on configuring the keypad, see the AccuPyc II 1345 Installation
Instructions and Checklist [part number 134-42875-02].

Data can be entered into the system using either a:

n Keypad (or a keyboard). Used if a computer with the analyzer software installed is not con-
nected to the analyzer. In this case, any section of this manual referring to software can be omit-
ted. All instructions specific to the keypad are designated with the keypad icon.

n Computer. Used if the computer with analysis software is installed and connected to the ana-
lysis module. In this case, this section of this manual can be skipped.

2 Data Entry with Keypad
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2 Data Entry with Keypad

ABOUT THE DISPLAY

Use these instructions for keypad installations only. If a computer is attached to the
module, skip this section. All setup functions will be done in the analysis software.

The display provides information about the analyzer and the current operation. During operations,
different types of information are shown in lines two, three, and four. Line one always displays the
unit and serial number. If the Alt key is pressed, the 3 in 10 cm3 will change to a + (plus sign). This
is an example of the display when the analyzer is in an idle state, or the Reload prompt.

Line Description
First Displays the unit number, serial number, and nominal cell volume of

the selected unit. Up to five analysis modules may be attached;
though the initial module, containing the keypad and display, will con-
trol all units.

Second At the Reload prompt, manual control, or an automatic operation, this
line contains three characters, separated with dashes. The first
character represents the Fill valve, the second represents the
Expand valve, and the third represents the Vent valve.

Valve states: X = Closed, O = Open

During user interface, this line shows the command currently in use.
Third Displays status of the current operation, or Reload when in an idle

state. When the Reload prompt is displayed, this line may also con-
tain an asterisk (*), indicating there is a message in the queue. Dur-
ing certain functions (such as Setup), this line contains a prompt for
additional information.

Fourth At the Reload prompt, shows the current pressure and temperature
alternately, where:

n P = Pressure
n T = Temperature

This line is also used to choose options, enter information, or provide
information about the current operation.
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ABOUT THE KEYPAD

A keyboard can be connected to the USB port on the rear panel of the AccuPyc II.
Commands can be entered from either the keypad or the keyboard.

A. Primary function
B. Alternate function
C. ALT key

Most keys on the keypad perform one primary and one alternate function. The primary function of
any key is indicated by the number or command on the face of the key. The alternate function is
indicated by the command above the key. The top right corner of the display screen will show a + 
(plus sign) when the Alt key is pressed and the alternate function mode is entered. See About the
Display on the previous page.

To select the:

n Primary function. Press only the key. Primary functions are labeled on the key face. For
example; press 4 to enter the number 4.

n Alternate function. Press Alt, then press the key. Alternate functions have blue labels above
the key. For example; press Alt + 4 to start an analysis. If the Alt key is pressed accidentally,
pressing it a second time will cancel its function.

The alternate functions for keys 7 (FILL), 8 (EXPAND), and 9 (VENT) are executed differently.
Press Alt + 1 first to enter Manual mode then press the alternate key. For example: press
Alt + 1 + 7 to manually control the Fill valve. Press Alt + CLEAR to exit Manual mode.

About the Keypad
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2 Data Entry with Keypad

Functions can be entered from the keyboard.

Keypad
Function

Key Sequences Description
Keypad Keyboard

Decimal (.) . . Enter a decimal point, a dash for sample or
instrument ID, a slash for date, or a colon for
time.

Number keys
(0 through 9)

0 - 9 0 - 9 Enters the numbers 0 through 9.

Calibrate Alt + .
(decimal)

Ctrl + O Calibrates the pycnometer.

Zero Alt + 0 Ctrl + Z Zeroes the pressure transducer.

Manual Alt + 1 Ctrl + Y Provides manual control to open and close
valves.

n Fill (Key 7)
n Expand (Key 8)
n Vent (Key 9)

The state of the valve is shown on the second
line of the display, where X=Closed and
O=Open.

Alt + CLEAR exits manual mode.
Set Up Alt + 2 Ctrl + U Display or edit:

n Analysis parameters
n Report options
n Calibration data
n Data transmission parameters
n Unit types
n Operating language
n Date and time

Keypad and Keyboard Functions
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Keypad
Function

Key Sequences Description
Keypad Keyboard

Transmit Alt + 3 Ctrl + T Transmits analysis or calibration data. Trans-
mits a partial report if an automatic operation
is in progress.

Analyze Alt + 4 Ctrl + A Performs an analysis.

Review Alt + 5 Ctrl + R Review completed analysis or calibration
data.

Print Alt + 6 Ctrl + P Prints an analysis or calibration report. If an
automatic operation is in progress, prints a
partial report.

Unit Alt +
CHOICE +
(unit num-
ber)

Ctrl I then 1-6 Selects unit (when multiple analysis modules
are attached).

Escape Alt + CLEAR Esc Discards all data entered in the current mode
and returns to display mode. Cancels an auto-
matic operation in progress. Exits manual
mode.

CHOICE CHOICE Ctrl + N Display the next message when in display
mode.
Display the next multiple choice item when in
command mode.

CLEAR CLEAR Ctrl + X Clear a message when in display mode.
Clear an entry when in command mode.

ENTER ENTER Enter or Ctrl +
M

Complete an entry or begin an action.

SAVE SAVE Ctrl + W Save the information and return to display
mode.

Keypad and Keyboard Functions (continued)

About the Keypad
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2 Data Entry with Keypad

SYSTEM COMMANDS

The display of the pycnometer remains at the Reload prompt until a command is initiated by
pressing a key on the keypad. Commands start an analysis or other automatic operations and
allow modification of operating parameters.

Command Description
Analyze Performs an analysis

Calibrate Calibrates pycnometer volume, temperature, or pressure

Manual Opens and closes valves manually

Print Prints reports

Review Reviews the results of the last operation (analysis or calibration)

Set Up Set up system options and operating parameters

Transmit Transmits data through a serial communications line

Zero Zeroes the volume or pressure transducer

While an automatic operation is in progress, no commands can be initiated, other than
Print or Transmit.

A prompt to enter information or choose an option displays on the third and fourth lines of the
pycnometer display when a command is entered. The third line contains a description of the
requested information and the fourth line displays a default value (when applicable). To use the
default value, press ENTER. For example, press Alt + 2 to display:

To select Analysis Parameters, which is the default option, press ENTER.

If not using the default option, use the keypad to enter or choose other responses. There are two
types of prompts:

n Data entry prompts. Followed by a colon (:). Use the keypad to enter the value, then press
ENTER. Entering a value that is "out of range" will result in a beep and a message showing the
range; enter a value in the range displayed.
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n Multiple choice prompts. Contain a fixed set of responses followed by a question mark (?).
To select a multiple choice response, press CHOICE until the response is displayed, then
press ENTER.

At any time while entering information:

n Press SAVE to save the information and return to the Reload prompt.
n Press Alt + CLEAR to discard the information and return to the Reload prompt.

System Commands
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2 Data Entry with Keypad

CANCEL AN ANALYSIS

To cancel an analysis, press Alt + CLEAR.

Press ENTER within five seconds to cancel the operation. A notification that the automatic
operation has been canceled will be displayed.

When canceling an operation, messages are displayed indicating that termination is in progress.
The termination process, which vents the system, takes about 30 seconds and returns to the
Reload prompt.

To view the data that have been collected, press CHOICE.

The following prompt is displayed if no cycles have been completed.
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MANUAL MODE

Press Alt + 1 to enter manual mode, allowing manual control of the Bypass, Fill, Expansion, and
Vent valves.

A. Fill valve
B. Expansion valve
C. Vent valve

The Bypass valve is only available on the 2000 cm3 units and the High Pressure Core
Pycnometer units.

Display Text Description
Manual WhenManual is shown, manually open and close the Fill,

Expansion, and Vent valves by pressing:

n 5 - Opens and closes the Bypass valve
n 7 - Opens and closes the Fill valve
n 8 - Opens and closes the Expansion valve
n 9 - Opens and closes the Vent valve
The three characters in the second line of the display show the state
of the valves (Fill, Expansion, Vent). X = Closed.O = Open.

Press SAVE to exit Manual mode and return to display mode.

Prolonged opening of all three valves at one time may cause excessive loss of helium.

Manual Mode
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2 Data Entry with Keypad

TRANSMIT DATA

Transmitted Data on page D - 1

The AccuPyc RS-232 interface transmits report data to a computer using the standard ASCII file
format. Reports may be transmitted in a single column format or a spreadsheet format.

n Press Alt + 3 to transmit report data.
n Press Alt + CLEAR to cancel report data transmission.

ANALYSIS PARAMETERS

This option enables specific analysis and calibration parameters. Although the Setup Type is
shown as Analysis Parameters, these same prompts are used to specify calibration parameters.
The pycnometer is shipped with default values; however, these settings may be modified to meet
laboratory requirements.

After each selection, press Enter to display the next prompt. If data results are to be e-mailed
automatically after analysis, specify e-mail parameters using the instructions in the AccuPyc II
1345 Installation Instructions and Checklist [part number 134-42875-02].

Enter appropriate analysis and report parameters for the current analysis. The chosen or specified
parameters in Set Up determine what prompts and information are displayed for the analysis.

Display Text Description
Setup Type?
Analysis Parameters

Press ENTER to accept Analysis Parameters.

Number of Purges: Key in the number of purges to be performed. Purging cleans the
sample cell and expansion chambers before an analysis begins.
The greater the number of purges, the cleaner the sample will be
when analyzed.

The range is 0 to 999. For calibration, 10 is sufficient.
Purges fill pressure Key in the fill pressure. For most applications, the default of 19.500

psig is adequate. Typically, the greater the fill pressure, the easier it
is to measure the volume precisely. However, a lower pressure
may be required for some samples.

The range in psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

High Pressure sample chamber:

The range in psig is 0 to 500.
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Display Text Description
The range in kPag is 0 to 3450.

Number of Cycles Key in the number of cycles to be performed. A cycle is a series of
functions which produce a single volume measurement.

The range is 1 to 999. For calibration, 10 is sufficient.
Cycle fill pressure Key in the fill pressure. For most applications, the default of 19.500

psig is adequate.

The range in psig is 0 to 19.850.
The range in kPag is 0 to 136.86.

High Pressure sample chamber:

The range in psig is 0 to 500.
The range in kPag is 0 to 3450.

P1, P2 end by?
[selection]

Choose the manner in which to end the pressure measurement.
Press CHOICE to make a selection.

The available options are Equilibrate and Fixed interval.
Equilibration Rate: (Does
not display for Fixed
Intervals)

Select Equilibrate at the P1, P2 end by? prompt. Pressure
measurement will end when the entered rate is obtained. Key in the
equilibration rate.

A high rate will produce faster results, but results may not be as
precise as desired. The lowest rates may cause errors when some
materials (such as those with appreciable vapor pressures or
organics) are analyzed.

The default setting is 0.0050 psig/min.
The range in psig/min is 0.0001 to 9.0000.
The range in kPag/min is 0.0007 to 62.0500.

High Pressure sample chamber:

The range in psig is 0.001 to 99 minimum (the default is 0.05)
Interval Time: (Does not
display for Equilibrate)

Select the Fixed interval at the P1, P2 end by? prompt. Pressure
measurement ends when the specified time is reached. Key in the
interval time.

The range is 10 to 99999 seconds.

Analysis Parameters
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2 Data Entry with Keypad

Display Text Description
Use Run Precision? Allows early termination of the analysis when certain criteria are

met.

n Yes. The analysis terminates after five consecutive cycles are
within the specified tolerance. Always request a large number
(50 to 99) of runs. The number of runs is determined through the
Number of Cycles option. With a small number of runs, the ana-
lysis stops when the selected number is reached, even if the spe-
cified tolerance has not been met.

n No. Run Precision is not used.

Percent Full Scale: This prompt only displays if Yes is selected for Run Precision and
more than five cycles have been requested.

Enter the run precision volume tolerance which is expressed as a
percentage of nominal cell volume (sample capacity).

The range is 0.01% to 50.00%.
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REVIEW DATA

The Review function allows review of and editing of the results of the last operation – analysis or
calibration – along with its entered parameters. It is important to review and print the report before
starting another operation. Data are no longer available for review on the display when another
operation is started; however, data results are saved in the control module and can be reviewed
using a web browser.

Review Data with a Web Browser

Data results for the last five analyses are saved in the control module for each attached unit.
These results can be viewed by accessing a web browser. To use this feature, connect to a
network.

1. Press Alt + 2 to access Setup. Then press CHOICE until Communications is displayed.
2. Press ENTER to display a prompt showing that the IP Address mode is DHCP.

The display may show Specify, depending on how the IP address was assigned.

3. Press ENTER to view the assigned address on the display. If the address was specified, the
display shows IP Address? and the entered address. This line is editable since it is specified
and not assigned automatically. An assigned address cannot be edited.

4. Make a note of the IP address.
5. Press Alt + CLEAR to return to the Reload prompt.
6. Access the web browser and type in the IP address.
7. Press Enter to display the serial number(s) of the attached unit(s).

Review Data
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2 Data Entry with Keypad

8. Click the serial number of the unit containing the data to review. A window displaying the
data files for the last five analyses, and for the zero (slope) and volume offset files is dis-
played.

The files are in .HTML format and are assigned the name used as the Sample ID. If sample
identifications are not used, Untitled is assigned and appended for each file.

9. Click the file to view the data results. The progress of a current operation can be monitored
by reloading the page.

10. Use the File > Print option to print the results.
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VIEW DATA RESULTS

Press Alt + 5 to view data results.

Reports are generated after analysis and calibration, and remain available for viewing or printing
until another automatic operation (other than zero) is performed. When an automatic operation is
performed, data from the previous operation are no longer available for viewing on the display.

A display report is always generated regardless of the specified destination and contains:

n Analysis. The average density (or volume) and the deviation from the mean.
n Calibration. Average cell volume (or expansion volume) and the deviation from the mean.

PRINT A FILE

Contact Micromeritics Customer Service for information on supported printers.

Press Alt + 6 to print a report of the last operation; analysis or calibration. If Alt + 6 is pressed
during an automatic operation, a partial report is printed.

Reports are generated after analysis and calibration, and remain available for viewing or printing
until another automatic operation (other than zero pressure) is performed. Previously generated
reports are deleted whenever a new automatic operation begins.

For each attached analysis module, the data for up to five analyses are stored in the control
module. These data sets can be viewed using a web browser when connected to a network.

An asterisk next to a cycle number indicates that it has not been included in calculations.

n Analysis. Volume, density, deviation for each cycle, an average of all cycles, the date and time
the analysis was started and completed, and the temperature of the cell chamber.

n Calibration. Cell and expansion volumes and deviations for each cycle, an average of all
cycles, and the date and time the calibration started and completed.

View Data Results
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3 ABOUT THE SOFTWARE

Software in 21CFR11 Environments on page 3 - 20

The AccuPyc II Pycnometer’s unique run precision reports data from five consecutive runs that
are within a user-specified tolerance. This feature allows early termination of analyses, thereby
decreasing the number of runs needed for accurate results.

Analysis provides the measurement of sample volume, from which density can be derived
automatically if the sample mass is entered. The unit comes preprogrammed with default
conditions and ready to perform analyses. It can be reprogrammed to meet specific needs.
Analyses can be modified by entering the number of purges and purge fill pressure, number of
cycles and cycle fill pressure, equilibration rate, and run precision. Modifying these parameters
allow control of the primary portions of the analysis; purge and run.

When the PC software is not running, the AccuPyc II can be operated in keypad mode. For
example; if the computer is inoperative, analyses can be performed using the keypad.

If running the FoamPyc module, an option to select a Standard method is available so that
analyses on other types of sample materials can be performed.

MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Selections Description
File Use to manage files used by the application— such as sample files, ana-

lysis conditions files, report options files, etc.
Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit 

[n] displays on the menu bar for each analyzer attached to the computer.
Reports Use to start or initiate reports and view the results.

Options Use to change presentation options, set the method and active metals
defaults, configure signal calibration, manage libraries, select units, and
create report styles.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Use to access the embedded operator manual, Micromeritics web page,
and information about the application.

Main Menu Bar Options

3 About the Software
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3 About the Software

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Selections Description
Add Adds an item to the list.

Add Log Entry Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscalemeans that the x- and y- ranges
will be set to show all the data. If Autoscale is not selected, the entered
range is used.

Axis Range On report parameters windows, the From / To fields are enabled when
Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field
label name)

Use to enter additional information about the sample, such as a sample
lot number, sample ID, etc.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window and displays a prompt to either accept or
reject changes.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments to display in the report header about the sample or
analysis.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables, deletes the selected information.

Destination Selects the report destination.

Common Fields and Buttons
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Selections Description
Edit When working with report parameters, highlight the item in the Selected

Reports list box and click Edit to modify the report details.
Exit Exits the application. If a file is open with unsaved changes, a prompt

displays the option to save the changes and exit or exit the application
without saving the changes. If an analyzer is currently operating, an
additional prompt displays to confirm exiting from the software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field or accept the default. Select to save the file as a spread-
sheet (.XLS), a portable document format (.PDF), or an ASCII text
(.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From / To Indicates the From and To range for x- and/or y-axes when working
with report parameters windows.

Insert Inserts one row above the selected row in the table.

List Creates a list of samples or other types of files. The list will contain the
file name, date/time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-
ues.

Common Fields and Buttons (continued)

Common Fields and Buttons
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3 About the Software

Selections Description
Replace All Selects another .SMP file where the values will replace all values for

the active sample file. The original file will remain unchanged. No
analysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis, and
reporting parameters.

Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. A portion
can be saved as a separate, stand-alone file, such as Analysis Condi-
tions or Report Options, when saving sample information.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or
messages. Enabled only in Service Test Mode.

Instrument Schematic. Displays a schematic of the analyzer system.

Common Fields and Buttons (continued)
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OPTION PRESENTATION
Options > Option Presentation

For 21CFR11 environments, see Software in 21CFR11 Environments
on page 3 - 20.

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted Displays the sample file in a single window like the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered
to change to the Basic or Advanced display option. This display type
is typically used in laboratories — such as the pharmaceutical
industry — where analysis conditions must remain constant. The
Advanced option is not available in the view selector at the bottom of
the window when using the Restricted display option.

Always Open Edit View Opens files with a Complete status in the tabbed file editor rather
than in the editor view.

Show Cup Properties Enable to show the cup properties for a pycnometry analyzer.

Show Asphalt Options Enable to show the asphalt properties for a pycnometry analyzer.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

Option Presentation
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3 About the Software

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.

Option Presentation Examples

Advanced view Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.
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FILE STATUS
In the File Selector window, theMic Description column and theMic Status column display the file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of
standard Windows functions.

File Status Description
Analyzing Sample files that are currently used for analysis.

Complete Sample files used in an analysis that is completed.

No Analysis Sample files that have not been used to perform an analysis.

File Status

File Type File Name
Extension

Analysis Conditions .ANC

Methods .MTH

Report Options .RPO

Sample Cup .CUP

Sample Information .SMP

SPC Report .SPC

File Type and File Name Extension

File Type File Name Extension
Spreadsheet .XLS

Unicode .TXT

File Types for Printing or Exporting

File Status
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3 About the Software

KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressingO to open the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Selections Description
Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Helpmenu.

Alt + I Opens theOptionsmenu.

Alt + R Opens the Reportsmenu.

Alt + W Opens theWindowmenu.

Ctrl + N Opens a new sample file.

Ctrl + O Opens the File Selector window.

Ctrl + P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F5 Opens the File Selector window listing report options files.

F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

Shift + F2 Opens the File Selector window listing sample information files.

Keyboard Shortcuts
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DEFAULT METHODS

Options > Default Method
A Default Method determines the default sample identification format and sequence number. A
Default Method is a template of specifications that go into a newly created sample file. It allows for
the definition of complete sets of parameters for each type of sample commonly analyzed, so that
only a single selection is required for each new sample file created.

The initial contents for new sample and parameter files come from the default method. The default
method can be edited like other sample files. The default method's Replace All button can be
used to set the defaults from an existing sample file.

Default Methods
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3 About the Software

ANALYZER STATUS

SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log
Use to display a log of recent analyses, calibrations, errors, or messages.

Selections Description
Add Log Entry [button] Use to enter information to appear in the sample log report that can-

not be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Analysis/
Calibration/
Message [check box]

Select the logs to display.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Instrument Log
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SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic
Use to display an analyzer schematic. To operate the valves and elevator from this window,
manual control must be enabled (Unit [n] > Enable Manual Control).

A. Sample chamber
B. Expansion chamber

Icon or Symbol Description
Open Valve. Green indicates an open valve.

n Fill Valve. Allows gas to pressurize the first chamber.
n Expansion Valve. Allows gas from the first chamber to flow into the

second chamber.
n Vent Valve. Vents gas from the system.

Closed Valve.

n Yellow— indicates a closed valve with manual control enabled.
n White — indicates a closed valve with manual control not enabled.

Sample Chamber.

Expansion Chamber.

Analyzer Schematic Icons

Show Instrument Schematic
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3 About the Software

Icon or Symbol Description
Pressure and temperature readings. Displays for either the expansion
chamber or the sample chamber, depending on the unit configuration.

Gas flow direction.

Analyzer Schematic Icons (continued)

Instrument Schematic Shortcut Menus

Each manually controlled schematic component has a shortcut menu displaying the operations
available for that particular component. To access the shortcut menu, hover the mouse pointer
over the component and right-click.

Icon or Symbol Description
Valve options Close. Closes the selected valve.

Open. Opens the selected valve.

Schematic Shortcuts
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SHOW STATUS

Unit [n] > Show Status
Use to show the current status for each port. If multiple units are attached to the computer, go to
Unit [n] > Show Status for the indicated unit.

Selections Description
Cycles The current cycle and the number of cycles requested. For example,

2 (current) of 10 (requested).
Density Last computed density and standard deviation.

Elapsed Time The elapsed time of the current step.

Equilibration The measured equilibration rate and the limit.

Operation The operation, task, and the step in progress.

Pressure The pressure in the sample chamber.

Sample The name of the sample file being analyzed.

Temperature The temperature of the sample chamber.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Show Status

Show Status
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3 About the Software

EXPORT FILES
File > Export
Exported Data Example on page B - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to a file.

1. Click List and open an .SMP file.
2. Select an experiment and the applicable options.
3. ClickOK.

LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.
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Example of
File List

List Files

AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022 3 - 15



3 About the Software

OPEN A SAMPLE FILE
File > Open > [.SMP File]

File Status Description
Analyzing Tabbed file editor.

Complete
No analysis

Report window.

File Status

If a sample file with a Complete status is opened, to review a report, click the report name in the
view selector drop-down list at the bottom of the window.

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.
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SOFTWARE UPDATES

A User Account Control in the Windows operating systemmust be enabled to ensure
all components of the Micromeritics application are correctly installed. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.Micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

Existing Confirm application users and groups are not affected by software updates.
Any changes to Confirm users and Confirm groups must be made using Windows
Users and Groups.

Software Updates
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3 About the Software

REINSTALL OR MODIFY THE SOFTWARE

If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

The Setup program is located on the installation media. After initial software installation, if
changes need to be made to the analyzer setup, reinsert the Setupmedia and follow the prompts.

n Reinstall the software version [n]
n Add an analyzer
n Move an analyzer
n Remove an analyzer
n Change analyzer setup
n Reinstall calibration files for an analyzer
n Uninstall
n Reset security to default

To access the Setup program:

1. Insert the Setupmedia into the media drive.
2. Locate and double click the Setup.EXE file.

If the IP address needs to be changed on the computer connected to the analyzer,
refer to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP address must be 192.168.77.100.
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SOFTWARE UNINSTALL
Uninstall Software in 21CFR11 Environments on page 3 - 24

The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.

UNINSTALL THE SOFTWARE USING THE KEYPAD
1. Insert the Setupmedia into the media drive.
2. Select the Uninstall option.
3. Follow the prompts.

UNIT SELECTION
Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.

Standard FoamPyc

Software Uninstall
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3 About the Software

SOFTWARE IN 21CFR11 ENVIRONMENTS

The Micromeritics Confirm applications for 21CFR11 environments require an
operating system of Windows 10 Professional or Windows 10 Enterprise or higher.
Management of users and groups is performed in Windows Users and Groups.

The Micromeritics Confirm application enables laboratory managers to develop analysis methods,
enforce industry standards, and produce audit trails. It also enables laboratory analysts to perform
analyses and produce reports.

USER PERMISSIONS

Confirm User Name Description
mic_[analyzer model
number]_controller

mic_[analyzer model number]_controller is the user name used by all
installations.

n This user should have complete control over the installation dir-
ectory.

n The application is launched under this user name and has this
user’s privileges to the windows file system.

n This user should not be used by anyone or any other software that
is not a Micromeritics application.

n The system administrator has the option of modifying this account
so that the password never expires. Alternatively, if the password
does expire while the application is running, the application auto-
matically changes the password for this account.
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Confirm Group Name Description
Developer Group The default Developer group name is

mic_[analyzer model number]_developer. Members of the
Developer group:

n have rights to all functions of the Micromeritics application - includ-
ing Advanced option presentation which allows the creation and
modification of methods, sample files, and parameter files.

n can run an analysis.
n can also be assigned Administrator rights which control the user

profiles.

Analyst Group The default Analyst group name is
mic_[analyzer model number]_analyst. Members of the Analyst
group:

n have access to the Basic presentation option only.
n may create sample files from pre-defined methods and can modify

only a limited number of input fields.

Software in 21CFR11 Environments
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OPTION PRESENTATION FOR 21CFR11 ENVIRONMENTS
Options > Option Presentation

Presentation Display Description
Advanced Displays all parts of sample and parameter files. Navigate to para-

meter windows by selecting the tabs across the top of the window.
Basic Displays sample information in a single window. This display option

is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Show Cup Properties Enable to show the cup properties for a pycnometry analyzer.

Show Asphalt Options Enable to show the asphalt properties for a pycnometry analyzer.

Show Splash Screen Enables (or disables) the splash screen upon application startup.

Option Presentation Display

For members of the Developer group only. To change the view from Advanced
(for Developers) to Basic (for Analysts), click the view selector drop-down list at the
bottom of the window. Select either Advanced (when in Basic view) or Basic (when
in Advanced view).
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Example of Developer view Example of Analyst view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and
specifies report options.

n The Save button is disabled on sample files with a Complete status.
n When the Preview button is used to view reports for sample files with an unsaved status, the

report will have a Preview watermark.
n The Save As and Print buttons on the report window are also disabled.

CREATE A NEW FOLDER
File > Create New Folder
Provides the option to create and name a new folder in the Confirm application folder. This option
may not be available depending on how the IT Administrator configures Windows permissions.

Software in 21CFR11 Environments
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3 About the Software

SYSTEM AUDIT TRAIL
File > System Audit Trail

Lists the current user, successful and failed application user login attempts, and contains a
description of all the changes made to sample files. Contains an audit trail of all system
initializations, user login attempts, and sample analyses.

UNINSTALL SOFTWARE IN 21CFR11 ENVIRONMENTS

When the software is uninstalled using uninstall.exe, only the files required to run the application
are removed. Parameter files, sample files, reports, calibration files, and data files are not
removed.

To uninstall the software, double-click the uninstall.exe file located in the software installation
directory, then follow the prompts.

To uninstall the Micromeritics Confirm application, the owner of the application
directory and its contents must be set to the account of the administrator that is
removing the application installation. This account must also have permission to
modify the application directory and its contents. This may require modification to the
owner and to the access permissions of the application directory and its contents.

Upon uninstalling the Confirm application, the system administrator should go into
Windows Users and Groups to remove the Confirm users and groups. See the
Confirm Administrator Guide [part number 004-42821-01].

Depending on the network, Windows may not allow the uninstall.exe program to run. If this
happens. follow these steps:

1. In Windows Users and Groups, verify that the current user is not a member of the analyst
group or developer group. If so, remove the user from the group(s). Log OFF, then log back
ON to the computer.

2. In Windows Explorer, in the Confirm installation directory, double-click the uninstall.exe file
to run the uninstall program.
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4 SAMPLE FILES
Option Presentation on page 3 - 5
Software in 21CFR11 Environments on page 3 - 20

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, specifies report options, and may be
displayed in Advanced, Basic, or Restricted presentation display mode.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either before or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

CREATE SAMPLE FILES
Options > Option Presentation > [Advanced / Basic / Restricted]
File > New Sample > [.SMP File]
File > Open > [.SMP File]

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a
member in the Developer group using information in this section.

4 Sample Files
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4 Sample Files

Example of a Pycnometer Sample File

Each analysis must be linked with a sample file before the analysis can proceed. A sample file can
consist of parameter files; however, parameter files can also stand alone. See Parameter Files
on page 5 - 1.

The values specified in the parameter portions of the default sample file are saved as the defaults
for new sample files. To navigate from one set of parameters to another, select the parameter tab
across the top of the window.

The Basic and Restricted formats use predefined parameter files to create a sample file.

When using the Basic option presentation, switch to Advanced to edit parameter file
values. When using the Restricted option presentation, parameter files cannot be
edited.

A bar code reader may be used to enter text into many of the fields on the Sample
Description window. Use a mouse to click in the field first where information is to be
entered then scan the bar code with the bar code reader
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Selections Description
Cup mass [text box] Displays when Show Cup Properties in option presentation is

enabled. Enter the cup mass.
Geometry [button] Enter material properties when using the FoamPyc application.

Entered. Select to enter the geometric volume and when using
Correction using cell dimensions selection. The Active Area is the
total geometric surface area of the sample - excluding any sides that
contain a skin.

Calculate. Select the shape of the sample and enter the dimensions.

Number of Pieces. The number of pieces making up the sample.
Material Parameters
[button]

SeeMaterial Parameters on page 4 - 6.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified inOptions > Default
Method.

Sample [text box] Enter a sample description.

Sample cup
[drop-down box]

Displays when Show Cup Properties in option presentation is
enabled. Select a sample cup file from the drop-down list or click Edit
to create and save a new file for sample cup properties. See Sample
Cup on page 4 - 5.

Sample Files for Pycnometry Analyzers

Create Sample Files
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4 Sample Files

Selections Description
Sample mass
[text box]

Enter the sample mass.

Submitter [text box] Enter submitter identification information. This text box may have
been renamed or may not display if modified inOptions > Default
Method.

User Parameters
[group box]

These fields are primarily used for the SPC (Statistical Process Con-
trol) reporting to specify sample characteristics or its manufacturing
process but may be used for other data by entering specific analysis
conditions or sample criteria. The entered parameters display on the
Summary Report. This option may not display (or may have a dif-
ferent field label) if modified in the through Options > Default
Method.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Sample Files for Pycnometry Analyzers (continued)
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SAMPLE CUP
Options > Option Presentation > Show Cup Properties
File > Open > [.CUP File]
(or click the Sample Description tab when in Advanced option presentation)

Use to set the sample cup mass and density.

Selections Description
Density [text box] Enter the density of the sample cup.

Mass [text box] Enter the sample cup mass.

Sample Cup [text box] Enter a description of the sample cup.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Sample Cup Properties for Pycnometry Analyzers

Sample Cup
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MATERIAL PARAMETERS
File > Open > [.SMP File]

Material parameters are used to report porosity or total solids concentration when using the
Standard analysis method.

Selections Description
Bulk Density / Envelope
Density [selection]

Calculated from a volume that includes pores.

Liquid Density [text box] Density of the liquid.

Solids Density [text box] Density of the solid sample.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Material Parameters for Pycnometry Analyzers
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5 PARAMETER FILES

For 21CFR11 environments, this section is applicable only to members of the
Developer group; however, members of the Analyst group may find information in this
section helpful. Sample file information that is available to Analysts is created by a
member in the Developer group using information in this section.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The following file types can exist as part of the sample file as well as individual parameter files:

File Type File Extension
Analysis Conditions .ANC file extension

Report Options .RPO file extension

Sample Cup .CUP file extension

5 Parameter Files
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5 Parameter Files

ANALYSIS CONDITIONS
File > Open > [.ANC File]
(or click the Analysis Conditions tab when in Advanced presentation option)

Analysis conditions specify the parameters used to guide an analysis.

Analysis method is for the FoamPyc
application only

Selections Description
Analysis Conditions
[text box]

Displays the description of the file. If this is a new file, the descrip-
tion specified in default methods is displayed.

Analysis gas [text box] The gas to be used for analysis gas (helium is recommended).

Analysis method
[selection]

For the FoamPyc application only.

n Standard. Select Record equilibration data then enter the cri-
teria (if recording equilibration data).

Enter the cell wall density.

n Correction using cell dimensions.Measures the closed cell
fraction and corrects for the cells damaged while cutting the
sample to the necessary size and shape. This is accomplished
by using either the average cell diameter or the cell chord

Analysis Conditions for Pycnometry Analyzers
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Selections Description

length (as defined in ASTMmethod D-6226-15) and the
measurements of the sample to determine the volume of the
cut cells. This volume is deducted from the total volume of the
open cells measured by the pycnometer.

n Correction by recutting sample. Corrects for the cut cells by
using two separate measurements. For the 2nd measurement,
the sample is recut to double the amount of cut surface. The
observed difference in cut open cell volume is applied as a
correction to the initial measured volume. This method offers
the distinct advantage that no assumptions are needed about
the relative amounts of open and closed cells.

n No correction. Does not correct for cut cells. It is used for
materials with predominantly open cells where good accuracy
can be achieved without correction. The accuracy level
deteriorates as the percentage of closed cells increases.

Enter the initial and final pressure, and the pressure increment.

n Compressibility test. The fill pressure is increased incre-
mentally over the sample with each repeat of the P1, P2 cycle
(where P1 is the initial pressure to which the sample is charged,
and P2 the final pressure after expansion). The apparent vari-
ation of the measured sample volume with the average pres-
sure is determined. This test is an approximate indication. It is
not intended to be an exact measure of the volume com-
pressibility.

Enter the Low pressure and the Fracture pressure.

n Cell fracture test. A perfectly rigid foam is assumed. First, a
P1, P2 cycle is performed at the lower of two specified P1 pres-
sures, and the results stored. A second cycle is performed at a
higher specified value of P1, then a third cycle identical to the
first cycle is performed. The difference between the volume of
the sample on the first measurement and on the third meas-
urement is reported as the volume of fractured cells. It is
assumed that cells fracture by exposure to the highest pressure
(2nd cycle) so that when the third measurement is made, the
measured sample volume has decreased from the first cycle by
the amount of the closed cell volume which was fractured.

Cycle fill pressure Enter the fill pressure for the cycles. Typically, the default of

Analysis Conditions for Pycnometry Analyzers (continued)
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5 Parameter Files

Selections Description
[text box] 19.500 psig is appropriate for most samples.

End equilibration by:
[group box]

Rate. Equilibration ends when the rate of pressure change drops
below the entered amount.

Time. Equilibration ends when the specified time interval is
attained.

Number of cycles
[text box]

The number of cycles to be performed. A cycle is a series of func-
tions which equals to a single volume measurement.

Number of purges
[text box]

The number of purges to be performed. A higher number of
purges will mean a cleaner sample.

Percent full scale
[text box]

Enabled when Use run precision is selected. Enter the run pre-
cision volume tolerance which is expressed as a percent of nom-
inal cell volume (sample capacity).

Purge fill pressure
[text box]

The purge fill pressure (in psig or kPa). For FoamPyc analyses,
the typical pressure is 3.5 psig. For analyses on standard
samples, the measured volume is more precise if a greater fill
pressure is used. The default of 19.500 is appropriate for most
standard analyses. Some materials, such as organic polymers,
may require a lower pressure in order to limit permeability into the
sample matrix.

The default is 500 psig for the High Pressure sample chamber.
Record P1 equilibration
data [check box]
Record P2 equilibration
data [check box]

Record first. Enter the number of cycles to be recorded at the
beginning of the analysis.

Record last. Enter the number of points to be recorded at the end
of equilibration.

Use run precision
[check box]

Select to use run precision. This feature provides early termination
of the analysis when certain criteria are met. The analysis ter-
minates after five consecutive cycles are within the specified tol-
erance. Typically, a large number (50 to 99) of cycles is requested.
If a small number of runs is selected, the analysis stops when the
entered number is reached even though the specified tolerance
has not been met. If fewer than five cycles are requested, this fea-
ture is disabled.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Analysis Conditions for Pycnometry Analyzers (continued)
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REPORT OPTIONS

File > Open > [.RPO File]
(or click the Report Options tab when in Advanced presentation display)

If using the FoamPyc application, reports for all FoamPycMethods are fixed and
cannot be created or selected from within the application.

Report options specify the types of reports to be generated from an analysis and allow for
customization of reports such as axis scale, axis range, and column headings.

Report Options files can be customized to accommodate standard analysis requirements.
Reports can be generated automatically after each analysis or at any time during or after an
analysis. A report generated during an analysis only includes data collected up to the time of the
report.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.

Selections Description
Overlays [button] Click to open theGraph Overlay Samples window. Click Browse to

select sample files to overlay into a plot.
Report Options
[text box]

Displays the description of the file. If this is a new file, the description
specified in default methods is displayed.

Selected Reports
[selection]

Select the report names to include in the report.

Report Options for Pycnometry Analyzers

Report Options
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5 Parameter Files

Selections Description
Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[check box]

Select then enter a report title to appear on the report header.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Report Options for Pycnometry Analyzers (continued)

5 - 6 AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022



6 PERFORM AN ANALYSIS
Handling System Components on page 11 - 5

In 21CFR11 environments, users are required to login to the Confirm application to
start an analysis. Once the analysis window is opened, manual control is disabled
until the analysis has completed. During analysis, pausing and resuming is allowed,
however, steps cannot be skipped.

An analysis can be performed from either the computer application or directly from the keypad on
the analyzer.

PREPARE AND LOAD A SAMPLE

FOAMPYC METHODS

About the FoamPyc Module on page 1 - 5

FoamPyc Methods are intended to conform to the procedures detailed in ASTM Test Methods
D-6226 and D-3576. Prepare samples according to the methods outlined in these procedures.
Once the sample is prepared and placed into the sample chamber, analysis can begin.

STANDARD METHOD

Samples must be properly prepared to obtain accurate results. Samples must be free of moisture
in order to obtain true sample mass and to avoid the distorting effect of water vapor on the volume
measurement. The following procedures are recommended; however, modifications may be
necessary for some materials:

n Heat-sensitive materials may have to be dried by long-time exposure to silica gel, freeze dry-
ing, etc.

n Materials having a low melting point may be dried using the purge process. In this case, do not
weigh the sample and cup until after the purge and analysis have been completed.

Avoid exposure of the dried sample to atmospheric moisture during each step of the preparation
process. This means weighing as rapidly as possible and installing in the instrument without
unnecessary delay.

Keep the cap on the cell chamber except when actually inserting or removing a
sample. If the chamber remains uncapped, water vapor will adsorb on the inner sur-
face of the chamber and temperature instability will occur; either condition can affect
analysis results.

6 Perform an Analysis
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6 Perform an Analysis

1. Weigh the empty sample cup.
2. Place as large a quantity of sample as is possible in the cup (cup should be at least two-

thirds full). Pack powders and fluffy materials (if permissible) to obtain maximum sample
weight in the cup.

3. Place the sample cup with sample in a drying oven. The amount of time the sample must be
heated depends on the material and the temperature it will tolerate; this may have to be
established by other tests.

4. Remove the sample cup from the oven and transfer it to a desiccator provided with active
desiccant. Allow it to cool until near room temperature. Minimize air exposure of the sample.

5. Use this equation to determine the sample mass. (If volume only is to be measured, skip
this step.)

Masssample = Masssample+cup – Masscup
6. Remove the cell chamber cap, place the sample cup (with sample) into the cell chamber,

then replace the cap.

It is best not to lay the cap down while loading the sample. Immediately replace the cap
when the sample is loaded. This will prevent particles from accumulating on the greased
surface.

7. If using a temperature-controlled AccuPyc, perform the following steps before proceeding:
a. Power on the bath circulator and specify the temperature for analysis. (Refer to the

manufacturer manual for instructions on operating the bath circulator.)
b. Allow the temperature to stabilize to the set temperature. Observe the temperature

reading on instrument schematic.
8. If using a TECmodule, ensure the temperature reading has stabilized at the specified point.

6 - 2 AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022



PERFORM AN ANALYSIS USING THE SOFTWARE

Unit [n] > Sample Analysis
After the sample has been properly prepared and loaded into the sample chamber, start the
analysis.

1. Click New to create a new sample file or click Browse to select an existing file.
2. Click Report after analysis to generate reports automatically when the analysis is com-

plete. On the Report After Analysis Settings window, select Report after analysis and spe-
cify a report destination. To export the report, select Export after analysis and specify a
report destination.

3. ClickOK to return to the previous window.
4. Ensure the correct Chamber Insert is selected.
5. Click Start to start the analysis. A window displays data as they are collected. A short delay

is encountered before the port status at the bottom of the window changes from the Idle
state.

6. If running a FoamPyc analysis that requires recutting the sample, a message displays indic-
ating the sample should be cut.

a. Remove the sample chamber cap, then remove the sample cup. Replace the cap
before performing the next step.

b. Cut the sample and return it to the cup.
c. Remove the cap, place the cup back into the sample chamber. Replace the cap.
d. ClickOK to complete the second analysis.

Perform an Analysis using the Software
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6 Perform an Analysis
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PERFORM AN ANALYSIS USING THE KEYPAD
Prerequisites:

n Specify analysis and report parameters, and
n Prepare and load sample
n Press Alt + 4 to display the Sample ID prompt. Enter an appropriate identification. Press .

(decimal) to insert a dash.
n Press ENTER to display the Description prompt.

Most users display this prompt only when a keyboard is attached to the pycnometer.

1. Press ENTER to display the Sample Mass prompt. Enter the sample mass.
2. If an analytical balance is connected to the module, press the appropriate button on the bal-

ance to transfer the sample mass while this prompt is displayed.
3. Press ENTER to display the Chamber Insert prompt if using an insert. Press CHOICE until

the appropriate insert is displayed, then press ENTER.
4. Press ENTER to begin the analysis. Operational status messages display during analysis.
5. When the analysis has finished, the pycnometer beeps three times and the display returns

to the Reload prompt.

Do not remove the cell chamber cap when the pycnometer is pressurized. The
sample may be discharged from the chamber.

6. Ensure the pressure reads approximately 0 (zero), then remove the cell chamber cap and
remove the sample from the chamber.

7. Replace the cell chamber cap or load another sample.

Display Text Description
Analyze Sample ID: Enter sample identification for the current analysis. Sample ID can

be up to 20 numbers and dashes. Press . (decimal) to insert a dash.
Analyze
Description Line 1:

Enter the description for the current sample. A prompt for Line 2 of
the description is displayed.

Perform an Analysis using the Keypad
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6 Perform an Analysis

Display Text Description
Analyze Sample Mass: Enter a value for the sample mass. Displays only when Density is

selected for Analysis display mode. It does not display if Volume is
selected.

The range is 000.0000 to 10000.0000 g.

The range for the 2000 cm3 AccuPyc is 000.0000 to 25000.0000 g.

This field will also accept input from a connected analytical balance.
While this prompt is displayed, press the appropriate button on the
analytical balance to transfer the mass (refer to the manufacturer’s
manual for the appropriate command).

Analyze Chamber
insert?

Select the insert to be used.

n None, 0.1 cm3 (for 1 cm3 unit)
n None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
n None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
n None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Press CHOICE until the appropriate insert is displayed or None if an
insert is not being used.

Analyze Cup Mass? Enter the mass of the sample cup.

Analyze
[ENTER] to start
[ESCAPE] to cancel

ENTER. Starts the analysis. The analysis begins and operational
status messages are continually displayed during analysis

ESCAPE. Cancels the analysis.

For keypad and/or keyboard functions or commands not listed in this table,
see About the Keypad on page 2 - 3.
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QUICKSTART ANALYSIS
Unit [n] > QuickStart Analysis
Perform an Analysis using the Software on page 6 - 3

Use to analyze a series of samples of the same type and same analysis conditions. Sample files
will be created using selected method.

QuickStart Analysis
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6 Perform an Analysis

SEQUENCE ANALYSIS
Unit [n] > Sequence Analysis
Use to analyze the same sample using different sample files.

Selections Description
Chamber Insert
[selection]

Select the chamber insert to be used for analysis.

Pause between
analyses [check box]

When this option is selected, the system will return to the sample
selection window after each analysis. Click Start to run the next ana-
lysis. As each analysis is run, the sample file is removed from the
Samples Files list box.

Report After Analysis
[button]

Generates reports automatically to the specified destination when
each analysis completes.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Sequence Analysis
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REVIEW ANALYSIS

Use these instructions for keypad installations only. If a computer is attached to the
module, skip this section. All setup functions will be done in the analysis software.

The Review function allows review of the results of the last analysis operation. Press Alt + 5 to
review or edit analysis results. The analysis information can also be edited through the prompts.
The prompts that display during the analysis review depend on the options selected in Setup >
Analysis Parameters and Report Options.

1. Press Alt + 5 to display the Sample ID prompt containing the sample identification.
2. Press ENTER to display the Description prompt containing an additional description. This

prompt typically is not used unless a keyboard is connected to the analyzer.
3. Press ENTER to display the Sample Mass prompt containing the sample’s mass.
4. Press ENTER. The Start prompt containing the start date and time of the analysis is dis-

played.
5. Press ENTER. The End prompt containing the ending date and time of the analysis is dis-

played.
6. Press ENTER. The first of the prompts containing data is displayed. The [n] displayed in the

example prompts represents the cycle number.
7. Continue pressing ENTER to view data. Press CHOICE to exclude data from report cal-

culations. An asterisk will display indicating that it will be excluded. Press CHOICE again to
remove the asterisk.

8. Press SAVE to return to the Reload prompt.
9. Press Alt + 6 to print report results.

Display Text Description
Sample ID:
(sample identification)

Identification entered for the analysis.

Sample Mass:
(mass)

Sample mass for the analysis (if Density was chosen as Analysis
display mode).

Temperature:
(sample chamber temp)

Sample chamber temperature.

Start:
(time) (date)

Time and date the analysis began.

Time: HH:MM:SS

Date: DD/MM/YY

Review Analysis
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6 Perform an Analysis

Display Text Description
End:
(time) (date)

Time and date the analysis completed.

Time: HH:MM:SS

Date: DD/MM/YY
Dn[n] = (density)
Dv[n] = (deviation)

or

V[n] = (volume)
Dv[n] = (deviation)

Density or Volume (depending on the selection made for Analysis
display mode).

[z]: cycle number.

Press CHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk indicates that it has been excluded.
Press CHOICE again to remove the asterisk. Each time CHOICE is
pressed to exclude (or include) the value, a new deviation is
calculated and displayed.

Press SAVE to return to the Reload prompt. Press SAVE to
automatically recalculate the collected data and update data
reduction messages in the queue.

For keypad and/or keyboard functions or commands not listed in this table,
see About the Keypad on page 2 - 3.
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7 ABOUT REPORTS
Review this section for information on the Reportsmenu options as well as customizing and
running reports.

Reports can be generated for data:

n collected on a sample that has completed analysis
n collected on a sample currently being analyzed

OPEN AND CLOSE REPORTS
Reports > Open Report > [.REP File]
Select one or more .REP files to open, then clickOpen.

Reports > Close Reports
Closes all open reports.

START REPORTS
Reports > Start Report
Starts the selected report. Select a file from the Files list. Ensure the selected file has a status of
either Complete or Analyzing.

7 About Reports
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7 About Reports

SPC REPORT
Reports > Open SPC Report
Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more
efficient to select only the necessary variables.

Example of SPC Report Option

Selections Description
AccuPyc / FoamPc
[selection]

Select the instrument type.

Edit [button] Defines the x-axis and y-axis of each graph. Highlight a report in the
Selected Reports list box, then click Edit.

SPC Report
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Selections Description

Regression report. Select to run a Regression report.

Control chart. Select to run a Control chart report.

X-Axis.
n Autoscale. Allows the y-axis to be scaled automatically. To spe-

cify a range, deselect this option and enter a range in the From
and To fields.

Select the order in which x-axis statistics are placed. Sort by: 

n Time. Time the files were analyzed.
n File name. Alphanumeric order.
n Date. Date the files were analyzed.
n Minutes.Minutes elapsed from the first file placed on the list,

which is the earliest-analyzed file.
n Days. Number of days elapsed from the first file placed on the list,

which is the earliest analyzed file.

Y-Axis. ClickOptions to define the control chart graph.

SPC Report (continued)

SPC Report
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7 About Reports

Selections Description

n Center Line. Displays placement options for the center line in the
graph. Select Entered to specify placement of the line orMean to
place the center line at the calculated mean value for the selected
samples.

n Limit Lines. Displays limiting lines options. Lines can be placed
at some multiple of the standard deviation or at specified positions
(Entered). When Entered is selected, enter the High limit and Low
limit fields with appropriate values.

Label data [check box] Use to label the points on the plot to correspond with the values in
the sample files.

Quantities [button] The selected items display as graph variable selections in the
Regression report and the Control Chart report. If report options for
NLDFT Advanced PSD are required, clickMore.

Recalculate
SPC results when
reporting [check box]

The first time this option is used, the time it takes to generate the
report is lengthened. The second time the report is generated, if
using the same sample files used in the initial calculation, it is
recommended that this option not be selected since the data was
recalculated previously. If a sample file is added or removed from the
report after the initial recalculation, this option should be selected
again to ensure the data from the newly added or removed sample
file is recalculated.

SPC Report (continued)
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Selections Description
Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report. Select the samples
in the Available Files list box then click Add to move them to the
Selected Files list box. ClickOK when done.

Selected Reports
[group box]

Select the report names to include in the report. Highlight the report
name, then click Edit to modify report parameters.

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title
[text box]

Enter a report title to appear on the report header.

SPC Report options
[drop-down box]

Select the applicable Control or Regression report from the list.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

SPC Report (continued)

SPC Report
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7 About Reports

REPORT FEATURES AND SHORTCUTS
Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

n After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.
n The report zoom feature provides the viewing of fine graph details and the ability to shift the

axes.
n All reports contain a header displaying file statistics.

A. Data display (graph or text)
B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

If configured, the report header can also contain a graphic and/or a title.

n Tabular and graphical reports contain sample and analyzer statistics such as analysis date /
time, analysis conditions, etc.

n The headers contain notes of sample file changes occurring after analysis.
n Summary report headers contain the same information as tabular and graphical reports with

the exception of notes.
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REPORT HEADER SHORTCUTS
Right-click in the report header to display header shortcuts.

Selections Description
Copy header as text Copies the report header as text. Text is copied to the clipboard and

then can be pasted into other documents.
Edit Opens a dialog box for editing the report title.

Report Header Shortcuts

Report Features and Shortcuts
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7 About Reports

REPORT TOOLBAR
The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list
box, then click Show.

A. Data display (graph or
text)

B. Header
C. Generated tabs
D. Graphic
E. Title
F. List box
G. Toolbar

Selections Description
Default Style [button] Specifies default report parameters for fonts and curve properties.

Delete [button] Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button] Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button] Displays the Print window for report output.

Reports [group box] Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button] Displays the selected or hidden report in the Reports list box.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Report Toolbar
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TABULAR REPORT FEATURES AND SHORTCUTS
Right-click in the report header to display tabular report shortcuts.. Right-click on a column to
display column shortcuts.

Selections Description
Align column Select to change the column alignment to either left, right, or

centered.
Copy table as text Use to copy the report contents to the clipboard as tab-delimited text.

It can then be pasted into another document.
Edit title Use to edit the report title and/or title font attributes. Click Font to

modify font attributes.
Move column Right-click the column to be moved. SelectMove column on the short-

cut menu and select Left or Right for the move.
Rename column Right-click the column to be renamed. Select Rename column on the

shortcut menu and enter the new column name.
Resize column Right-click the column to be resized. Select Resize column on the

shortcut menu and enter the new column width in inches.
Show column Displays a list of all columns. Click a column to add a checkmark to

show the column or remove the checkmark to hide the column.
Table data font Right-click in the report data. Select Table data font on the shortcut

menu.
Table header font Right-click in the report data. Select Table header font on the shortcut

menu.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Tabular Reports Shortcut Options

Report Features and Shortcuts
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7 About Reports

GRAPH FEATURES AND SHORTCUTS

Display graph report shortcuts by right-clicking in the body of the graph report.

Selections Description
Autoscale all axes Returns the report to full view after using the zoom feature.

Copy data Copies the report data to the clipboard. It can then be pasted into
other software programs as tab-delimited columns or copied as an
overlay onto another graph.

Copy graph Copies the report graph to the clipboard. It can then be pasted into
other software programs or copied as an overlay onto another graph.

Edit axis Use to edit the selected axis properties.

Autoscale minimum / maximum. To manually specify minimum /
maximum autoscale, deselect the option and enter the new amount
in the text box.

Grid lines. Use to change how to display major / minor grid lines.

Invert scale. Use to invert the scale.

Linear / Logarithmic. Select the option to scale the graph as linear

Graph Shortcuts Options
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Selections Description
or logarithmic.

Scale font. Use to modify the font for the scale label. Deselect Use
default font to enable font options.

Title. Use to edit the selected axis label.

Title font. Use to modify the font for the selected axis label. Deselect
Use default font. Select new font attributes for report data. Enable
Use default font to reset default fonts.

Edit curve Use to edit selected curve properties.

Color. Click to change the curve color.

n Curve group box. Use to change the interpolation, point style and
pen style for the selected curve. These options are disabled if Use
default fill style is selected in the Histogram group box.

n Histogram group box. Enabled only if Histogram is selected in
the Style drop-down list. Use to specify the type of fill, fill color and
label position for the selected curve.

Label. Select where the graph point labels will display (left, right,
center, etc.) on the SPC report.

Style. Use to select another style for the collected data curve.

Title. Use to change the title of the selected curve.

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.

Graph Shortcuts Options (continued)

Graph Features and Shortcuts
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7 About Reports

Selections Description
Edit legend Use to change the legend location and font. Click Font to modify font

attributes.

Edit title Use to change the graph title and font. Click Font to change font
attributes.

Reset axis limited to
initial setting

Removes the cross-hair and returns the graph back to the initial set-
ting.

Show curve Displays a list of all curves. Select the curve to display.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Graph Shortcuts Options (continued)

7 - 12 AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022



AXIS CROSS-HAIR
Left-click on the graph to view the cross-hair coordinates.

Example of
Axis cross-hair feature

Graph Features and Shortcuts
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7 About Reports

GRAPH GRID LINES
Options > Graph Grid Lines

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.

Selections Description
Grid Line Styles
[selection]

Select if the major and/or minor grid lines should appear as solid or
dotted lines.

X-Axis / Y-Axis
[selection]

Select major and/or minor lines to display in reports for the
logarithmic and linear scales. Deselect this option to remove the grid
lines.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Graph Grid Lines

ZOOM FEATURE
Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal
view, right-click in the graph and select Autoscale all axes.
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GRAPH AND SAMPLE OVERLAYS

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

Use the graph overlay functions to compare multiple graph options. Graphical lines are
differentiated by the use of varying colored symbols outlined on a legend. Overlays may be
generated in two ways:

n Multiple Graph Overlays.Overlay two different types of graphs from one sample.
n Multiple Sample Overlays.Overlay graphs of the same type with that of the current plot.

This feature is available only when using Advanced option presentation. Go to
Options > Option Presentation > Advanced.

GENERATE MULTIPLE GRAPH OVERLAYS

1. Go toOptions > Option Presentation and ensure there is a checkmark to the left of
Advanced.

2. Go to File > Open and open the sample file.
3. On the Report Options tab, in the Selected Reports list box, highlight the graph to be used

for multiple overlays, then click Edit.

Graph and Sample Overlays
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7 About Reports

4. On the Plot Options window, select a quantity from the overlay list. If the x- and/or y-axes
are to be autoscaled, select Autoscale; otherwise, enter the From and To points for the
axes.

5. ClickOK then click Save.
6. Select the overlay X-axis, Y-axis, andOverlay options.
7. ClickOK to return to the Report Options tab.
8. Click Save, Save As, or Preview.

7 - 16 AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022



GENERATE MULTIPLE SAMPLE OVERLAYS

1. Go toOptions > Option Presentation and ensure there is a checkmark to the left of
Advanced.

2. Go to File > Open and open the sample file.
3. Click the Report Options tab.
4. In the Selected Reports list box, select the checkbox to the left of each report to include in

the graph overlay.
5. Highlight the graph to be used for multiple overlays, then click Edit.

6. On the overlay window, click the down arrow to the right of theOverlay field and selectOver-
lay Samples. Select other options as needed, then clickOK.

Generate Multiple Sample Overlays
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7 About Reports

7. In the Report Options tab, clickOverlays.

Example of Overlay window

8. On theOverlays window, move up to 25 files from the Available Files box to the Selected
Files box. If the files to be overlaid do not display in the Available Files list, click the Browse
icon to locate and select which graphs are to be overlaid.

9. ClickOK.
10. Go to Reports > Start Report. Select the report destination in the Settings group box.

Select the overlay file name in the Files list box, then clickOK.
11. In the pop-up Selected Reports list box, reports can be added or removed by double clicking

the entry. Selected reports are indicated by a checkmark to the left. ClickOK.
12. Reports display in a tabbed format. Click each tab to view each report.

Selections Description
Available Files
[selection]

Lists files that meet the selected criteria. Select the files to be com-
bined, then click Add. The selected files are moved to the Selected
Files list box.

Look in [button] Changes the file folder location. Click the Browse icon.

Selected Files
[selection]

Lists the files selected to be combined. Click Remove to move a file
back to the Available Files list box. ClickOK to combine the files.

Status [drop-down box] Selects the status of files to be combined.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Overlay Sample Selection
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REPORT EXAMPLES

COMBINED REPORT

Report Examples
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7 About Reports

SUMMARY REPORT
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TABULAR REPORT

Tabular Report
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7 About Reports

GRAPH REPORT
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OVERLAY REPORT

Overlay Report
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7 About Reports

EQUILIBRATION REPORT
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SAMPLE LOG REPORT

Sample Log Report
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8 SELECTED REPORT OPTIONS

In 21CFR11 environments, this feature is applicable to members of the Developer
group only.

To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

COMBINED REPORT

The Combined Reports option creates a single report from all selected reports. The Combined
Report contains no breaks between reports and no headings. Highlight the report, then click Edit
to edit report details.

8 Selected Report Options
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8 Selected Report Options

DENSITY AND VOLUME TABLE

Selections Description
Columns 1 though 7
[drop-down box]

Select a variable for each column.

Name [text box] Enter the name of the report.

Summary Data
[group box]

Select the average, standard deviation, and coefficient of variation
(C.V.) for report parameters.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Density and Volume
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DENSITY VOLUME VS CYCLE NUMBER TREND PLOT

There are four types of graphical reports available. Report titles are based on the parameters
selected for the x-axis and y-axis.

Selections Description
Autoscale x-axis
Autoscale y-axis
[check box]

When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically. Autoscalemeans that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Overlay [drop-down box] Select overlay plot options.
n A second y-axis can be selected to overlay with the variable in the

y-Axis field, or
n SelectOverlay Samples to overlay data of the type selected in the

y-axis field with the same type of data contained in other sample
files. To select other sample files, go to the Report Options tab
and click theOverlays button.

Plot curve
Plot points
[check box]

Select to display how data are plotted.

Density Volume vs Cycle Number Trend Plot

Density Volume vs Cycle Number Trend Plot
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8 Selected Report Options

Selections Description
Show +/-
[check box]

Select to place two horizontal lines on the graph. The top line will be
placed at a point relative to the average and standard deviation of the
data. The bottom line will be placed at the point entered in the adja-
cent field.

Show Average
[check box]

Select to show the average of all cycles. A horizontal line is placed at
the average point for the cycles.

Show Min
Show Max
[check box]

Horizontal lines are placed at the entered limits.

Show Reference
[check box]

Select to show a horizontal line placed at a reference point specified
in the adjacent field.

X-Axis [check box] Variables available for the x-axis.

Y-Axis [check box] Variables available for the y-axis.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Density Volume vs Cycle Number Trend Plot (continued)
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DENSITY VS TIME TREND PLOT
Density Volume vs Cycle Number Trend Plot on page 8 - 3

The Density vs Cycle Number Trend Plot and the Volume vs Cycle Number Trend Plot are
identical except for the x-axis units.

Density vs Time Trend Plot

AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022 8 - 5



8 Selected Report Options

EQUILIBRATION REPORT

This report is available only if the Record equilibration data option was selected on the Analysis
Conditions tab.

Selections Description
Autoscale x-axis
Autoscale y-axis
[check box]

When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically. Autoscalemeans that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

From cycle [text box] Enter the first cycle to report.

Report every
[text box]

Enter the interval between reported cycles.

Overlay cycles
[check box]

Select to overlay the number of cycles entered in the Report total of
field.

Overlay samples
[check box]

Select to overlay the last cycle in the current file with the last cycle
contained in other files. ClickOverlays on the Report Options tab to
select the other sample files.

Equilibration Report
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Selections Description
Plot curve
Plot points
[check box]

Select to display how data are plotted.

Report quantity
[drop-down box]

Select a variable to be reported.

Report total of [text box] Enter the number of cycles for this report. Enter up to 8 cycles.

Report every
[text box]

Enter time between points. Up to 60 seconds can be entered.

Show plot [check box] Generates a plot (graph) for the Report quantity field selection.

Show table [check box] Generates a tabular report for the Report quantity field selection.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Equilibration Report (continued)

Equilibration Report
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8 Selected Report Options

OPTIONS REPORT
TheOptions report provides information on the sample, its material properties, and analysis
conditions. This report cannot be edited.

PRESSURE AND VOLUME TABLE
Density and Volume Table on page 8 - 2

The Pressure and Volume Table and the Density and Volume Table are identical unless otherwise
noted.
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SAMPLE LOG REPORT
The Sample Log report displays:

n Automatic operations
n Information entered using Add Log Entry on the Sample Description tab
n Warnings and/or errors which occurred during analysis

The Sample Log Report cannot be edited.

SUMMARY REPORT

Example of Summary report

The Summary Report provides a condensed listing of data results. Select the type of information
to include in the report. If Pass/Fail is selected, theMin andMax fields are enabled. Enter the
minimum and maximum values for the pass / fail.

Sample Log Report
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8 Selected Report Options

TOTAL PORE VOLUME VS TEMPERATURE
Density Volume vs Cycle Number Trend Plot on page 8 - 3

The Total Pore Volume vs Temperature and the Density vs Cycle Number Trend Plot are identical
unless otherwise noted.
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VOLUME VS CYCLE NUMBER TREND PLOT
Density Volume vs Cycle Number Trend Plot on page 8 - 3

The Volume vs Cycle Number and the Density vs Cycle Number Trend Plot are identical unless
otherwise noted.

Volume vs Cycle Number Trend Plot
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9 DIAGNOSTICS USING THE SOFTWARE

Unit [n] > Diagnostics
Performs a leak test for the analysis module.

A. Suspend/Resume/Skip buttons
B. Port report buttons
C. Live graph settings

Selections Description
Estimated time Amount of time it takes to run the test.

File Shows a status bar of steps complete once the test begins.

Live Graph Select graph settings.

Next [button] Starts the next test.

Operator [text box] Name of the operator performing the diagnostic.

Repeat [button] Repeats the test.

Diagnostic Test

9 Diagnostics using the Software
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9 Diagnostics using the Software

Selections Description
Report Generates a report on data being collected . The reports are

displayed on the computer monitor only.
Report after test
[check box]

Automatically generates reports to the selected destination when the
test is complete.

Resume [button] Restarts the suspended analysis.

Sequence Sequence number assigned to the test.

Skip [button] Moves to the next step. This button is visible only when an analysis is
in progress. Select the ports to skip. In 21CFR11 environments,
steps cannot be skipped.

Start [button] Starts the test.

Status window Displays the status of the report.

Suspend [button] Suspends an analysis in progress.

Test [drop-down box] Select the appropriate test from the drop-down list.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Diagnostic Test (continued)

9 - 2 AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022



10 ABOUT CALIBRATION
Calibrate Using the Keypad on page 10 - 14
Calibrate Using the Software below
The pycnometer volume should be calibrated every time it is restarted. Cell volume and expansion
volume in the set up parameters are updated automatically upon calibration. Run an analysis with
an empty cup to see how close the average volume is to 0. It should be ±0.05% of full scale. If it is
not within ±0.05% of full scale, calibration is required.

CALIBRATE USING THE SOFTWARE

If calibrating using the keypad, see Calibrate Using the Keypad on page 10 - 14.

CALIBRATE PRESSURE SCALE

Unit [n] > Calibration > Pressure Scale
Opens the Calibrate Pressure Scale box.

Calibrates the pressure scale. Use an external reference device to determine the sample cell
pressure. Enter the value in the field, then click Done.

A Calibration report is not generated for the pressure scale. The entry is recorded in the
Instrument Log. To view the log, go to Unit [n] > Show Instrument Log.

1. Enter the current sample cell pressure.
2. Click Done. The pressure reading will be adjusted to the entered pressure.

10 About Calibration
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10 About Calibration

CALIBRATION REPORT

Unit [n] > Calibration > Calibration Report

1. Select the type of chamber insert used.
2. Select the report destination.
3. ClickOK to generate the report.
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CALIBRATE TEMPERATURE OFFSET

Unit [n] > Calibration > Temperature
Opens the Calibrate Temperature Offset box.

Calibrates the temperature offset. Use an external reference device to determine the sample cell
temperature. Enter the value in the field, then click Done.

A Calibration report is not generated for the temperature offset. The entry is recorded in the
Instrument Log. To view the log, go to Unit [n] > Show Instrument Log.

1. Enter the current sample cell temperature.
2. Click Done. Temperature reading will be adjusted to the entered temperature.

Calibrate Temperature Offset
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10 About Calibration

CALIBRATE ZERO CELL VOLUME

Unit [n] > Calibration > Zero Cell Volume
Use to calibrate the cell volume offset.

Selections Description
Analysis Conditions Specify conditions for the calibration.

Click Replace to replace the values with those from an existing
Analysis Conditions file. See Analysis Conditions on page 5 - 2.

Cell Volume Current cell volume (without an insert) or the volume of the selected
insert.

Expansion Volume Current expansion volume, and the date and time of calibration.

Insert
1 cm3 unit

n None
n 0.1 cm3

If None is selected, place an empty sample cup in the chamber.
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Selections Description
Insert
10 cm3 unit

n None
n 3.5 cm3

If None is selected, place an empty sample cup in the chamber.
Insert
1.0 cm3 and 100 cm3

unit

n None
n 35 cm3

n 10 cm3

If None is selected, place an empty sample cup in the chamber.
Insert
350 cm3 and 2000 cm3

units

n None
n Large
n Small

If None is selected, place an empty sample cup in the chamber.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

CALIBRATE ZERO PRESSURE

Unit [n] > Calibration > Zero Pressure
This option zeros the pressure transducer reading.

Click Start to calibrate the pressure offset.

Calibrate Zero Pressure
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10 About Calibration

RESET PRESSURE CALIBRATION

Unit [n] > Calibration > Reset Pressure Calibration
This procedure resets the pressure calibration to the factory default settings.

This option can be used when the pressure appears not to be reported correctly by the analyzer.
For example: a zero, negative, or unreasonably high reading is being consistently reported.
Resetting to nominal may restore normal pressure readings but a proper calibration should be
performed.

A popup warning indicates that when this option is used, the previous pressure calibration is lost
and the nominal calibration is used.

Temperature and volume calibrations are not affected by a reset of the pressure cal-
ibration.

ClickOK. The nominal calibrations may be sufficient. However, it is recommended to contact your
Micromeritics Service Representative and schedule a proper pressure calibration as soon as
possible since data accuracy may be compromised.
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CALIBRATE VOLUME SCALE

Unit [n] > Calibration > Calibrate Volume
Regulator Pressure on page 12 - 16

Calibrates the cell volume offset and expansion volume.

Although the instrument is calibrated prior to shipment, the pycnometer should be recalibrated to
laboratory atmospheric and environmental conditions.

1. Remove the chamber cap and place an empty cup into the sample chamber, then replace
the cap. If an insert is being used, place the insert and its sample cup into the chamber.

Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands when
handling sample cups, calibration standards, and inserts. See Handling System
Components on page 11 - 5.

2. Go to Unit [n] > Calibration > Calibrate Volume.

3. Enter the volume of the calibration standard (located on the outside of the calibration stand-
ards case shipped with the instrument) in the Volume of Calibration Standard field.

The value recorded on the case for a 10 cm3 pycnometer is the sum of the two standards,
and on a 350 cm3 pycnometer, the sum of the three standards.

4. Select theMeasured option.
5. Click Analysis Conditions to specify calibration parameters. Click Replace and select the

file Standard.anc. The values in the current file will be replaced with those contained in the
selected file. ClickOK, then clickOK again to return to the Calibrate Volume Scale win-
dow.

Calibrate Volume Scale

AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022 10 - 7



10 About Calibration

6. Click Start to begin the first phase of the calibration (volume offset). Status messages dis-
play until this phase is complete. When the phase has finished, a prompt display indicates
to insert the calibration standard.

7. Remove the sample chamber cap, then remove the sample cup from the chamber. Place
the cap back onto the chamber while placing the standard into the cup.

8. Tilt the sample cup and allow the standard to roll gently into the cup to prevent denting of the
cup.

n one standard is shipped with the 1-, 100-, and 2000 cm3 pycnometers
n two are shipped with the 10 cm3 pycnometer
n three are shipped with the 350 cm3 pycnometer

9. Remove the sample chamber cap, place the sample cup back into the chamber, and
replace the cap. Turn the cap clockwise to tighten.

10. Allow the standards to reach thermal equilibrium with the pycnometer.
n Wait 10 minutes for 1- and 10 cm3 pycnometer
n Wait 15 minutes for the 100 cm3 pycnometer
n Wait 20 minutes for the 350 cm3 pycnometer
n 30 minutes for the 2000 cm3 pycnometer
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11. Click Continue to complete the second phase of the calibration (volume scale). Status mes-
sages display until the calibration is complete.

12. Click Done to accept the new values, then clickOK.
13. Do not remove the standard from the sample chamber until the operation is verified. See

Verify Operation on page 10 - 11.

Selections Description
Analysis Conditions Specify conditions for the calibration.

Click Replace to replace the values with those from an existing
Analysis Conditions file.

Cell Volume Displays the current cell volume (without an insert), or the volume of
the selected insert.

Continue [button] Place the standard into the sample cup and click Continue to com-
plete the volume scale calibration.

Expansion Volume Displays the current expansion volume, and the date and time of cal-
ibration.

Insert 1 cm3 unit None, 0.1 cm3

10 cm3 unit None, 3.5 cm3

1.0 cm3100 cm3 unit None, 35 cm3, 10 cm3

350 cm3 and 2000 cm3 units None, Large, Small

If None is selected, place an empty sample cup in the chamber.

Calibrate Volume Scale

Calibrate Volume Scale
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10 About Calibration

Selections Description
Previous / Entered /
Measured
[check box]

Select the method for calibrating the cell and expansion volumes.

Previous. Uses the current values.

Entered. Enables the fields for the cell and expansion volumes.

Measured. Measure the cell and expansion volumes using a
reference standard.

Start [button] Begins the first segment of the volume offset calibration.

Volume of Calibration
Standard [text box]

The volume of the standard used for the previous calibration.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Calibrate Volume Scale (continued)
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VERIFY OPERATION

Verify operation of the pycnometer by performing an analysis on the calibration standard to
ensure that the pycnometer is operating properly.

1. Go to Unit [n] > Sample Analysis.
2. Click New to create a new sample file.
3. From theMethod drop-down list, select Default.
4. Click Save As, select a folder, and enter a file name.
5. Close the sample file editor.

6. Click Report After Analysis. Select the Report after analysis option, then clickOK.

7. Click Start to begin the analysis.

Verify Operation
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10 About Calibration

8. Compare the value displayed for the average volume to the value recorded on the cal-
ibration standards case. These two values should agree plus or minus the tolerance
obtained using the following calculation:
Tolerance = (chamber volume * 0.0003) + (Value recorded on Standards case * 0.0003)

Example: calculate the tolerance for a 10 cm3 pycnometer with a value of 6.372242 cm3

recorded on the case as :
Tolerance = (10 * 0.0003) + (6.372242 * 0.0003) = 0.003 + 0.0019116726 = 0.005 cm3

If the values do not agree, a leak may be indicated. Check the system for leaks. Then repeat
steps 1 through 6. If the values continue to disagree, contact your Micromeritics Service
Representative. See Diagnostics using the Software on page 9 - 1.

9. Remove the standards and place them back into the case.
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LOAD CALIBRATION FROM FILE

Unit [n] > Calibration > Load from File
Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using Unit [n] > Calibration >
Save to File prior to loading another calibration file. When loading a previously saved calibration
file, a backup of the current file is created and saved as [SN]last.cal. The backup file is overwritten
each time a new one is created.

Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE

Unit [n] > Calibration > Save to File
Use to save the current calibration settings to a backup file which can later be reloaded using the
Unit [n] > Calibration > Load from Filemenu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number
2013-04-25 Date the calibration file was saved
.CAL File name extension

Load Calibration from File
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10 About Calibration

CALIBRATE USING THE KEYPAD
Calibrate Using the Software on page 10 - 1

Use these instructions for keypad installations only. If a computer is attached to the
module, skip this section. All setup functions will be done in the analysis software.

The pycnometer volume should be calibrated every time it is restarted. Cell volume and expansion
volume in the set up parameters are updated automatically upon calibration. Run an analysis with
an empty cup to see how close the average volume is to 0. It should be ±0.05% of full scale. If it is
not within ±0.05% of full scale, calibration is required.

CALIBRATE FUNCTION

This command performs a full volume slope and offset calibration. Press ALT + . (decimal) to
access the Calibrate function.

Display Text Description
Calibration Type?
Volume

Press CHOICE until the option is displayed, then press ENTER.

n Volume
n Temperature
n Pressure
n Copy to an external device
n Load from an external device
n Reset Pressure Calibration
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CALIBRATION DATA

Display Text Description
Setup Type?
Calibration Data

Press CHOICE until Calibration Data is displayed, then press
ENTER.

Calibration Data
Chamber Insert?

Select Yes at the Request insert prompt in Report Options. Press
CHOICE until the appropriate insert is displayed, then press ENTER.

n None, 0.1 cm3 (for 1 cm3 unit)
n None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
n None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
n None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Calibration Data
Cell Volume:

Displays the cell volume determined during calibration. Cell volumes
can also be entered at this prompt. Press ENTER.

The range is 0.01 to 999.0000 cm3.

Calibration Data
Expansion Volume:

Displays the expansion volume determined during calibration. Press
ENTER.

The range is 0.5 to 999.0000 cm3.

Calibration Data
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CALIBRATE VOLUME

Place an empty cup into the sample chamber for Cal1 (volume offset). If using an insert, place the
insert and its appropriate sample cup into the sample chamber.

Display Text Description
Calibration Type?
Volume

Press ENTER to accept Volume (default) and display the next
prompt.

Calibrate Volume
Chamber insert?

Press CHOICE until the appropriate insert is displayed, then press
ENTER. Yesmust be selected for the Request Insert prompt in
Report Options for this prompt to display.

n None, 0.1 cm3 (for 1 cm3 unit)
n None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
n None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
n None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Calibrate Volume
Volume of Cal Std:

Enter the volume of the calibration standard to be used in the
calibration (located on the outside of the calibration standards case).
Some pycnometers require and are shipped with multiple standards.
In this instance, the value recorded on the case is the sum for all
standards and is the one that should be entered at the prompt. Press
ENTER.

The range is 0.1 to 999.0000 cm3.

Calibrate Volume
[ENTER] to start

Press ENTER to begin the calibration or Alt + CLEAR to cancel. The
volume offset is calibrated first (Cal1). When the first calibration is
complete, the pycnometer beeps three times and the next prompt is
displayed.
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Display Text Description
Insert Cal Std
[ENTER] to start

Place the calibration standard in the cup in the sample cell chamber
and replace the chamber cap. Press ENTER to calibrate the volume
(Cal2). Calibration continues and operational status messages are
continually displayed. After the operation is complete, the
pycnometer returns to the Reload prompt.

For best results, sample volume should be approximately equal to
the volume of the calibration standard. Therefore, if calibrating the 10
cm3 pycnometer for use with smaller sample volumes, use only one
standard. If using one standard, enter half of the value at the Volume
of cal std prompt. Press Alt + CLEAR to cancel the operation.

RESET PRESSURE CALIBRATION

Contact a Micromeritics Service Representative and schedule a proper pressure cal-
ibration since data accuracy may be compromised.

This option can be used when the pressure is suspected of not being reported correctly by the
analyzer. For example: a zero, negative, or unreasonably high reading is being consistently
reported. Resetting to nominal may restore normal pressure readings but a proper calibration
should be performed.

Display Text Description
Calibration Type?
Reset Pressure Cal

Press CHOICE until the desired option is displayed, then press
ENTER.

Reset Pressure cal?
[Yes / No]

Resets the pressure calibration to nominal values. Temperature and
volume calibrations are not affected. Nominal values may be
sufficient. Schedule a proper pressure calibration as soon as
possible, then press CHOICE.

Select Yes to reset the calibration to nominal values. Press ENTER.

Select No to contact your Service Representative to schedule a
proper pressure calibration. Press ENTER.

Reset Pressure Calibration
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10 About Calibration

REVIEW CALIBRATION

The Review function reviews the results of the last calibration operation.

The sample cell volume and the expansion cell volume are used for calculating the sample
volume. The cell volume and expansion volume are updated automatically when the pycnometer
is calibrated.

The prompts that display during a review of calibration data depend on the options specified
in Setup > Analysis Parameters and Report Options.

1. Press Alt + 5 to display the Chamber Insert prompt from which the insert can be selected (if
used).

2. Press ENTER to display the volume of the calibration standard. This volume can be edited
from this prompt.

3. Press ENTER to display theWhich Chamber prompt.
4. Press CHOICE to select whether to view the results for the sample chamber or the expan-

sion chamber.
5. Press ENTER to display a prompt showing the starting time and date.
6. Press ENTER to display a prompt showing the ending time and date.
7. Press ENTER to display the first of the prompts containing data. The [n] in this example rep-

resents the cycle number.

8. Continue pressing ENTER to view all of the data. Press CHOICE to exclude data from
report calculations. An asterisk will display indicating that it will be excluded.

9. Press SAVE to return to the Reload prompt.
10. Press Alt + 6 to print report results.

Display Text Description
Chamber insert?
(insert)

Displays the insert selected for the calibration or None if an insert
was not used. If the selection is incorrect, press CHOICE until the
correct one is shown, then press ENTER.

n None, 0.1 cm3 (for 1 cm3 unit)
n None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
n None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
n None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)
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Display Text Description
Volume of Cal Std:
(volume)

Displays the volume of the calibration standard that was used for the
calibration. Press ENTER.

Which Chamber?
(chamber type)

Select to view calibration data for the sample cell chamber or the
expansion chamber. Press CHOICE until the chamber is displayed,
then press ENTER.

The chamber type options are Cell volume and Expansion volume.
Start:
(time) (date)

Displays the time and date the calibration began. Press ENTER.

Time: HH:MM:SS
Date: DD/MM/YY

End:
(time) (date)

Displays the time and date the calibration completed. Press ENTER.

Time: HH:MM:SS
Date: DD/MM/YY

Cell[n] = (volume)
Dv[n] = (deviations)

or

Exp[n] = (volume)
Dv[n] = (deviations)

Displays the Volume, depending on the chamber type selected (Cell
volume or Expansion volume).

[n] represents the cycle number.

Press CHOICE to exclude the displayed density (or volume) from the
calculated average. An asterisk next to the density indicates it has
been excluded. Press CHOICE again to remove the asterisk and
have it included.

Each time CHOICE is pressed to exclude or include the value. A new
deviation is calculated and displayed.

Press ENTER to view the values for the next cycle.

Press SAVE to return to the Reload prompt. Press SAVE to
automatically recalculate collected data and add all data reduction
messages back into the queue.

Review Calibration
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10 About Calibration

CALIBRATE TEMPERATURE

This operation typically is performed by a Micromeritics Service Representative.

Press Alt + ., then press CHOICE until Temperature is displayed.

Display Text Description
Calibrate Temperature
Temperature:

Enter the temperature obtained from a reference temperature sensor.
Press ENTER to automatically return to the Reload prompt. Press
ALT + CLEAR to cancel the operation.

ZERO THE PRESSURE TRANSDUCER & CHAMBER VOLUME

The pressure transducer zeroes automatically before each cycle in an analysis or calibration;
therefore, it is not necessary to zero the unit for these operations. Typically, this function is not
required unless manually performing analyses for an extended period of time.

Press Alt + 0 to access the Zero function.

Display Text Description
Zero Type?
Pressure

Allows zeroing of the pressure transducer or the volume offset. Press
CHOICE until the option is displayed, then press ENTER. If choosing
Pressure, the next prompt is not displayed. Choices are Pressure and
Volume. Ensure the sample chamber is empty if selecting Volume.

Zero Volume?
Chamber insert?
None

Does not display for
Pressure

Displays when Volume is selected. Select Yes at the Request insert
prompt in Report Options. Press CHOICE until the appropriate insert
is displayed, then press ENTER.

n None, 0.1 cm3 (for 1 cm3 unit)
n None, 3.5 cm3, 1.0 cm3 (for 10 cm3 unit)
n None, 35 cm3, 10.0 cm3 (for 100 cm3 unit)
n None, 650 cm3, 1300 cm3 (for 2000 cm3 pycnometer)

Zero Volume
[ENTER] to start
[ESCAPE] to cancel

or

Zero Pressure
[ENTER] to start
[ESCAPE] to cancel

Press ENTER to begin the zero operation or Alt + CLEAR to cancel
the operation.

If zeroing the Volume, the purges and cycles specified in the current
analysis parameters are used to calculate the volume offset.

After the operation is complete, the pycnometer returns to the Reload
prompt.
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LOAD CALIBRATION DATA FROM A USB MEDIA

Display Text Description
Calibration Type?
Load from USB Stick

Press CHOICE until the option is displayed. Press ENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of
the unit. Press ENTER.

Local cal for SN: Key in the serial number. Press ENTER.

Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick Remove the USBmedia. The system automatically returns to the
Reload prompt. This prompt appears immediately after the
Calibration for SN prompt.

COPY CALIBRATION DATA TO A USB MEDIA

Display Text Description
Calibration Type?
Copy to USB Stick

Press CHOICE until the option is displayed. Press ENTER.

Insert USB stick
and press [ENTER]

Insert the USB device into the USB connector on the rear panel of
the unit. Wait a few seconds, then press ENTER.

Calibration for
SN (nnnn) copied

Display the unit for which calibration information has been copied.

Remove USB stick Remove the USBmedia. The Reload prompt displays. This prompt
appears immediately after the Calibration for SN prompt.

Load Calibration Data from a USB Media
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11 HARDWARE

ADD ANALYSIS MODULE TO CONTROL MODULE

Add Analysis Modules to a Temperature Controlled Module on page 14 - 2

Additional analysis modules provide the ability to increase productivity and/or provide a means for
analyzing different size samples concurrently. Multiple analysis modules can be connected to an
integrated controller / analysis module.

If installing an external TEC module, it is suggested that the TEC system be installed
first, to allow time for temperature to stabilize at the desired temperature, while the
AccuPyc is being installed. The TECmodule has a separate power cord and external
power supply.

A. Hardwired 8 pin mini-DIN
power cable for external
power supply.

B. Separate power cord for
external power supply. Con-
nect cable to wall outlet.

C. External power supply.
D. Mini DIN cable for power

and serial control data.
E. Module connection - 8 pin

mini-DIN IN port to connect
the control module or pre-
viously connected analysis
module (not shown).

F. Module connection - 8 pin
mini-DIN OUT port to con-
nect next analysis module.

Exit the application before powering off the analyzer.

1. Power OFF the control module.
2. Connect one external power supply cable to the back of the new unit and another external

power supply cable to each power adapter.
3. Connect a power cable to each external power supply.

11 Hardware
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11 Hardware

4. Attach one end of the DIN cable (provided in the module accessories kit) to the connector
labeledModule Connection on the back of the new unit.

5. Attach the other end of the DIN cable to the separate power adapter.
6. Attach the hardwired power adapter cable to the lower connector labeledModule Con-

nection on the back of the analysis module.
7. Plug the external power supply cables into electrical wall outlets.
8. Power ON the control module. If running the application software, start the application.
9. Verify the unit is recognized:

n If running the application software,
Unit [n]menus are added to the
menu bar for each analysis module
connected.

n If using the keypad for analysis,
press Alt + CHOICE + 2 to access
the additional analysis module. Unit
[n] appears in the upper left corner of
the display.

10. Calibrate the pycnometer. See Calibrate Using the Keypad on page 10 - 14 or Calibrate
Using the Software on page 10 - 1.
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ANALYTICAL BALANCE
The analytical balance tested by Micromeritics is Scientec model #ZSA120.

An analytical balance can be connected to a serial port on the computer and used to transfer the
sample’s mass directly to the AccuPyc II application.

1. Connect the analytical balance to the RS-232 port on the rear panel of the analyzer.
2. Go toOptions > Configure Balance to connect and set up an RS-232 balance to the ana-

lyzer.

Selections Description
Enable / Disable Select to enable or disable the attached balance.

Serial Parameter set the baud rate, parity, data bits, and stop bits. This field should not
require modification from the default values.

Serial Port Select which serial port is used to connect the balance to the ana-
lyzer.

Configure Balance

Analytical Balance
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11 Hardware

BRIGHTNESS CONTROL

To adjust the display brightness:

1. Insert a small flat head screwdriver into the opening.
2. Rotate the screwdriver until it engages in the slot, then turn clockwise to darken and coun-

terclockwise to lighten.
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HANDLING SYSTEM COMPONENTS

CALIBRATION STANDARD

n Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.
n Do not drop the standard into the sample cup. Roll the standard into the cup to prevent dam-

age.
n Always return the standards to the case. Standards are unit specific.

SAMPLE CHAMBER CAP

n Wear latex or nitrile, powder-free gloves to prevent transfer of oil from hands.
n Keep the cap on the sample chamber except when inserting or removing the sample cup.

When left uncapped, the sample chamber temperature may become unstable and/or
water vapor will adsorb on the inner surface of the chamber. Either of these conditions
can affect analysis results.

n Avoid laying the chamber cap on a work surface. Debris may collect on the greased surface of
the O-ring which can also affect analysis results.

n When multiple analysis modules are connected, never interchange sample chamber caps.
Caps are unit specific.

Handling System Components
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11 Hardware

RS-232 PIN ASSIGNMENT
The AccuPyc is a standard DTE device. The RS-232 port can be used to connect an analytical
balance for transfer of sample weight, or for transmitting data to a computer. The receiving device
must be configured to interface with the RS-232 pin assignments. Any signals that are not listed in
the RS-232 Pin Assignment table are ignored.

Pins Signal Description Data Direction
2 RXD Receive Data Into AccuPyc

3 TXD Transmit Data From AccuPyc

4 DTR Data Terminal Ready From AccuPyc

5 GND Ground N/A

6 DSR Data Set Ready Into AccuPyc

RS-232 Pin Assignments

The AccuPyc uses the DTR and DSR signals for hardware flow control. Ensure that the serial
device provides these signals. For example, if attaching to a computer (also a DTE device), use a
null modem cable which includes the designated signals. If transmission problems occur, ensure
that the signals are set up properly. If the signals are correctly configured, contact the receiving
device manufacturer for assistance.
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12 MAINTENANCE AND TROUBLESHOOTING
Parts and accessories are located on the Micromeritics web page.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the MSDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

When lifting or relocating the instrument, use proper lifting and transporting devices for
heavy instruments. Ensure that sufficient personnel are available to assist in moving
the instrument. The AccuPyc 1345 weighs approximately 7.9 - 26 kg (17 - 51 lb)
depending on configuration. The AccuPyc 1350 weighs approximately 11.5 kg (25.3
lb).

Use of a power cord or power supply not provided with the instrument could cause
personal injury or damage to the equipment. If a replacement is needed, contact your
Micromeritics Service Representative. Detachable power supply cords with an
inadequate rating could cause significant instrument damage or physical harm.

Do not add anything between the power cord and the power source that would
compromise the earth ground.

Do not remove or disable the grounding prong on the instrument power cord.

If the equipment needs to be relocated, check with your Micromeritics service
representative. The equipment must be positioned such that the mains supply is not
obstructed and is easily accessible to disconnect the equipment from the AC main
power supply.

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.Micromeritics.com).
n Error Messages document (PDF)
n Parts and Accessories

12 Maintenance and Troubleshooting
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12 Maintenance and Troubleshooting

Power indicator did not illuminate when analyzer was powered ON.

Cause A: Power or DIN cables not fully inserted.

Action A: Verify cable connections and connect any loose cable ends into proper out-
lets.

Cause B: No power at outlet.

Action B: Test the outlet. If there is no power, contact electrician.

Cause C: Plug prongs bent so that contact not made at outlet.

Action C: Unplug the power cable and re-plug into outlet. If indicator does not illu-
minate, have electrician adjust prongs or replace outlet or plug.

Cause D: Power cord damaged.

Action D: Have electrician check cord using test meter. Replace if defective.

Cause E: Loose internal connection, broken wire, or failure of internal power supply.

Action E: Contact a Micromeritics Service Representative for repair or replacement
information.

Specified pressure not reached or maintained.

Cause A: Chamber cap not properly closed.

Action A: Close chamber cap by turning fully clockwise.

Cause B: Chamber cap contains dust or debris or the O-ring is not properly greased.

Action B: Using a lint free tissue, clean the chamber cap and the rim of the cell cham-
ber. Lightly grease the chamber cap O-ring. See Chamber Cap O-Ring on
page 12 - 6.

Cause C: The chamber cap O-ring is not properly seated.

Action C: Check the chamber cap. Ensure that the O-ring is properly seated and that it
contains no scratches or cuts.

Cause D: The chamber cap O-ring is cut or scratched.

Action D: Replace the O-ring in the chamber cap. See Chamber Cap O-Ring on
page 12 - 6.

Cause E: Gas leaks in the cell chamber or expansion chamber.

Action E: Check the pycnometer for leaks. See Check the Cell and Expansion Cham-
bers for Leaks on page 12 - 8.

Cause F: The helium tank is low on gas or empty. Tank pressure should be at least 200
psi above regulator pressure.

Action F: Check tank. Minimum recommended pressure is 200 psig above regulator
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pressure. See Regulator Pressure on page 12 - 16.
Cause G: The shut-off valve on the gas cylinder is closed.

Action G: Ensure that the valve is open.

Cause H: The Zero offset (of pressure transducer) is too low.

Action H: Check offset by opening chamber cap. If pressure is negative (displayed on
instrument schematic), run a new zero offset. See Zero the Pressure Trans-
ducer & Chamber Volume on page 10 - 20.

Cause I: Dust filter on 2000 cm3 unit is clogged or leaking to atmosphere.

Action I: Clean the dust filter. See Clean the Dust Filter on page 12 - 10.

Helium drained from tank.

Cause A: Leaks in the gas line connection.

Action A: Pressurize the system. Close, then open the gas cylinder shut-off valve. If the
needle on the pressure gauge falls abruptly, a leak in the gas line connections
may be indicated. Check all gas line connections.

Cause B: Pycnometer was left in Manual mode with all the valves open or the fill valve
open and chamber cap off.

Action B: Close all valves, then attach a new tank of helium.

Unit will not equilibrate, or results are not reproducible.

Cause A: Sample outgassing.

Action A: Prior to analysis, remove moisture and contaminants from the sample. See
Prepare and Load a Sample on page 6 - 1.

Cause B: Dust filter on 2000 cm3 unit is clogged or leaking to atmosphere.

Action B: Clean the dust filter. See Clean the Dust Filter on page 12 - 10.
Cause C: Defective cap O-ring.

Action C: Check cap O-ring for defects. Regrease or replace the O-ring, if necessary.

Cause D: Debris on valves.

Action D: With manual mode enabled and with the cap installed, open all valves. With
helium flowing through the pycnometer, open and close the expansion valve
repeatedly for approximately one minute. This will remove sample con-
tamination, which may cause a leak, from the valve seat. Repeat the process
for the vent valve with the inlet and expansion valves open.

12 Maintenance and Troubleshooting
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12 Maintenance and Troubleshooting

SAFE SERVICING

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

To ensure safe servicing and continued safety of the instrument after servicing, service personnel
should be aware of the following risks:

Product specific risks that may affect service personnel:
n Electrical. Servicing or repair could require opening the outer panels and exposing ener-

gized electrical components.
n High gas pressure (500 psi models only). High-pressure gas leaks can pose a risk of injury

to service personnel.
n High temperatures (TECmodels only). Temperature controlled components internal to the

instrument may be hot and could pose a burn hazard to service personnel.

Protective measures for these risks:
n Electrical. The electrical components operate at low voltage (24V or less) and pose low risk

when energized. Maintenance, troubleshooting, and repairs should be performed with the
instrument de-energized whenever possible, in accordance with standard electrical safety
guidelines.

n High gas pressure (500 psi models only). A heavy-duty threaded cap will prevent acci-
dental opening of the chamber during operation. High pressure gas leaks will be indicated
by a loud hissing noise; in this event the gas regulator should be turned off until the leak is
corrected. Ensure the gas regulator is turned off and the gas supply line is vented before dis-
connecting the line from the instrument.

n High temperatures (TECmodels only). Ensure the temperature control is off and verify tem-
perature control components are near ambient temperature before servicing.

Verification of the safe state of the instrument after repair:
n All instrument panels and covers installed.
n Gas lines connected and pressurized to normal operating pressure with no leaks.
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POWER

The AccuPyc is designed to operate with a power supply of 90-264 VAC at 50/60 Hz. Noise-free
power of the correct voltage and frequency, with a safety earth ground, should be available
through a standard wall receptacle. The power outlet should be able to supply 15 amps@ 100 or
115 VAC ±10% or 7.5 amps@ 230 VAC ±10%. There should also be sufficient outlets for all
devices.

The external power adapter required for the AccuPyc is Micromeritics' part number
003-40054-00. Use of any other power adapter could damage equipment and/or
cause harm to the operator. The AccuPyc is intended to be powered from the output
of the approved power adapter rated Class III, manufacture by TRUMPower, P/N
TSA42-D21 (R1). Micromeritics supplies a suitably rated approved power supply cord
appropriate for the applicable country with the power adapter.

The AccuPyc 1350 is designed to operate with a power supply of 85-264 VAC at 50/60 Hz. Noise-
free power of the correct voltage and frequency, with a safety earth ground, should be available
through a standard wall receptacle. The power outlet should be able to supply 15 amps@ 100 or
115 VAC ±10% or 7.5 amps@ 230 VAC ±10%. There should also be sufficient outlets for all
devices.

The external power adapter required for the AccuPyc 1350 is Micromeritics' part
number 003-40001-02. Use of any other power adapter could damage equipment
and/or cause harm to the operator. The AccuPyc 1350 is intended to be powered from
the output of the approved power adapter rated Class I, manufactured by MeanWell,
P/N GET280A24-C6P. Micromeritics supplies a suitably rated approved power supply
cord appropriate for the applicable country with the power adapter.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the specifications stated above.

Power
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12 Maintenance and Troubleshooting

CHAMBER CAP O-RING
The cell chamber cap contains an O-ring that requires routine maintenance. The chamber cap O-
ring should be greased at the beginning of each period of use.

Fine fibers and particles between the O-ring and its sealing surfaces can cause leaks, as can
scratches or cuts in the O-ring or in the metal surfaces.

GREASE THE CHAMBER CAP O-RING
1. Turn the chamber cap counter-clockwise and lift it from the chamber.
2. Place the chamber cap on a clean surface with the O-ring side exposed.
3. Use a small drop of Dow Corning high vacuum grease (or equivalent).
4. Distribute the grease evenly and completely around the O-ring groove.

5. Replace the chamber cap.
6. If recalibrating the pycnometer, allow the pycnometer to warm up for 30 minutes before cal-

ibrating.
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REPLACE THE CHAMBER CAP O-RING
1. Use a pointed tool and carefully remove the O-ring from its groove in the cap. A small niche

is provided at the groove for placement of the tool.

Do not to scratch the metal surface of the chamber cap. Scratches could result in an
imperfect seal.

2. Clean the groove in the chamber cap using a small brush or clean, lint-free tissue
moistened with isopropyl alcohol.

3. Allow the chamber cap to dry thoroughly.
4. Use a small drop of Dow Corning high vacuum grease (or equivalent).
5. Grasp the O-ring with the two greased fingers. Distribute the grease evenly and completely

around the O-ring.

Apply the grease sparingly. Too much grease may alter cell volume while too little
grease results in an imperfect seal and leaks.

6. Place the O-ring back into the groove on the cap and, with the greased index finger, gently
press it back into position.

7. Ensure the O-ring groove is properly greased. SeeGrease the Chamber Cap O-Ring on
the previous page.

8. Replace the chamber cap.

Chamber Cap O-Ring
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12 Maintenance and Troubleshooting

CHECK THE CELL AND EXPANSION CHAMBERS FOR LEAKS
This procedure should be performed in a temperature-stable environment after the pycnometer
has been allowed to warm for at least two hours. Before performing this procedure, check the
chamber cap to ensure that it is not the source of leaks. It should be free from particles, the O-ring
should be properly seated, and should not contain excessive grease.

CHECK FOR LEAKS USING THE SOFTWARE

Before performing this procedure, check the chamber cap to ensure that it is not the
source of leaks. It should be free from particles, the O-ring should be properly seated,
and it should not contain excessive grease.

Unit [n] > Diagnostics
Diagnostics using the Software on page 9 - 1

CHECK FOR LEAKS USING THE KEYPAD

Before performing this procedure, check the chamber cap to ensure that it is not the
source of leaks. It should be free from particles, the O-ring should be properly seated,
and it should not contain excessive grease.

Check the cell and expansion chambers for leaks.

A. Fill valve
B. Expansion valve
C. Vent valve

1. Allow the pycnometer to equilibrate thermally in a room with a stable temperature.
2. Press Alt + 1 to enter Manual mode.
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3. If the system was previously open, manually purge the system before proceeding:
a. Press 8 to open the Expansion valve and 9 to close the Vent valve; X - O - X.
b. Press 7 to open the Fill valve. Once the sample chamber fills to the appropriate pres-

sure, press 7 to close the Fill valve.
c. Press 9 to open the Vent valve; X - O - O.
d. Repeat this procedure two or three times.
e. Press 8 to close the Expansion valve; X - X - O.

4. Press 7 to open the Fill valve;O - X - O.
5. Fill the sample chamber to 19.5 psig.
6. Press 7 to close the Fill valve; X - X - O.
7. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the

pressure should not decrease more than 0.007 psig (0.048 kPag) or increase more than
0.02 psig (0.14 kPag) in a two minute span.

n If the pressure does not decrease more than 0.007 psig (0.048 kPag) or increase more
than 0.02 psig (0.14 kPag) in a two minute span, proceed to step 8.

n If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than
0.02 psig (0.14 kPag) in a two minute span, temperature instability or a leak may be indic-
ated. Vent the system, then repeat steps 4 through 7 several times to verify that a leak is
indicated. If a leak is indicated, call a Micromeritics Service Representative.

8. Press 9 to close the Vent valve, 8 to open the Expansion valve, and 7 to open the Fill valve;
O - O - X.

9. Fill the chambers to 19.5 psig.
10. Press 7 to close the Fill valve; X - O - X.
11. Observe the pressure display. After an equilibration period (about 20 to 30 seconds), the

pressure should not decrease more than 0.007 psig (0.048 kPag) or increase more than
0.02 psig (0.14 kPag) in a two minute span.

If the pressure decreases more than 0.007 psig (0.048 kPag) or increases more than 0.02
psig (0.14 kPag) in a two minute span, temperature instability or a leak may be indicated.
Vent the system, then repeat steps 8 through 11 several times to verify that a leak is indic-
ated. If a leak is indicated, call a Micromeritics Service Representative.

Check the Cell and Expansion Chambers for Leaks
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12 Maintenance and Troubleshooting

CLEAN THE DUST FILTER

Applicable only to 2000 cm3 units and 100 cm3 high pressure units.

Dust from the sample may be carried into the instrument plumbing. A dust filter protects the
valves, minimizing valve leaks.

A. Filter port
B. Spring
C. O-ring (size 011)
D. Retaining screws
E. Cover plate
F. Filter
G. O-ring (size 006)

1. Press Alt+1 to enter Manual mode.
2. Close the Fill valve. Open the Expansion and Vent valves to ensure that the system is not

under pressure.
3. At the lower back of the instrument, remove the two screws which hold the dust filter cover

and remove the cover plate.
4. Remove the spring and the filter. Remove the small O-ring inside the filter port.
5. Clean all parts with alcohol. The filter may require sonication to dislodge dust. It should be

replaced if it becomes severely clogged.
6. Inspect the O-rings before re-assembly. A very thin coating of vacuum grease may be used.
7. Re-assemble.
8. Check for leaks:

a. Fill the system with gas.
b. Open Expansion valve.
c. Check for leaks by applying a leak detecting liquid around the dust filter cover.
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CLEAN THE PYCNOMETER
The exterior casing of the pycnometer may be cleaned using a clean, lint-free cloth, dampened
with isopropyl alcohol (IPA), a mild detergent solution, a 3% hydrogen peroxide solution, or a
detergent that is not corrosive to aluminum.

Do not immerse the pycnometer or the power cord in any liquids. Doing so could res-
ult in electrical shock to personnel or damage to the unit.

Do not allow liquid to penetrate the casing of the pycnometer. Doing so could result in
damage to the unit.

DECONTAMINATION OF THE PYCNOMETER

Always wear personal protection equipment appropriate for the type and level of con-
tamination.

In addition to following the instructions to clean the pycnometer, service personnel should use
compressed air to decontaminate internal components.

Clean the Pycnometer
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12 Maintenance and Troubleshooting

GUIDELINES FOR CONNECTING GASES

Analyzer Gauge should indicate
AccuPyc 22 psig (152 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

These instructions refer to the installation of a gas line, regulator, and gas cylinder for
each type of gas used. Expansion kits or other accessories may be used in the lab. If
so, special consideration should be given to these configurations when installing the
gas lines.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the MSDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

n Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders
close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure. Gas lines are typically five to six feet long.
Long gas lines, such as those used with gas cylinders placed in remote areas, must be
evacuated for an extended period of time to remove ambient gases. When possible, avoid
placing gas cylinders in remote locations. It is always best to have gas cylinders located near
the analyzer.

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines

are used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as
those with a herringbone covering, but the line may be coated internally with a polymer.

n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.

n Label the gas line at the analyzer inlet for proper identification and maintenance.
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n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-
sure reads approximately 500 psi (3500 kPa) on the high-pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

n Ensure the gas cylinder is closed before connecting to the analyzer.

Guidelines for Connecting Gases
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12 Maintenance and Troubleshooting

REPLACE A GAS CYLINDER

Analyzer Gauge should indicate
AccuPyc 22 psig (152 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended pressure could cause personal injury or dam-
age the instrument.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counterclockwise. Gas will be ven-
ted from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and

move the cylinder to an appropriate location.
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Connect a Gas Cylinder

1. Use an appropriate cylinder wrench to remove the protective cap from the replacement gas
cylinder.

2. Place the protective cap in a secure location. It will be needed to recap the gas cylinder
when it is depleted and replaced.

3. Attach the gas regulator to the gas cylinder connector. Hand tighten the nut, then use an
appropriate wrench to tighten an additional 3/4 turn.

Over-tightening the fitting may cause a leak.

4. Check for leaks at the high pressure side of the regulator and in the connector.
a. Turn the regulator control knob fully counter-clockwise.
b. Slowly open the gas cylinder shut-off valve, then quickly close it.
c. Observe the pressure on the high pressure gauge for approximately one minute.

n If the pressure is stable, proceed with the next step.
n If the pressure decreases, tighten the regulator connector nut until it becomes

stable. If the pressure does not remain stable, remove the regulator and clean all
contacts at the regulator connection, then reinstall the regulator.

5. Connect the gas line to the regulator and instrument. Turn the regulator control knob until
the low pressure gauge reads 22 psig.

Replace a Gas Cylinder
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12 Maintenance and Troubleshooting

REGULATOR PRESSURE

Tank pressure should be at least 200 psi above regulator pressure. Pressures less
than 200 psig indicate the tank is low on gas. Analyses are terminated automatically if
gas is depleted.

For a high pressure sample chamber configuration, set regulator pressure 20 psi
above cycle and fill pressure.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

SET REGULATOR PRESSURE WITH THE SOFTWARE

The Purge fill and Cycle fill pressures are specified in Analysis Conditions. Set the regulator
pressure at the higher of the two, plus 2.0 psig. For example; if the Purge fill pressure is set to
19.500 psig (134.445 kPag) and the Cycle fill pressure as 19.000 psig (131.000 kPag), set the
regulator pressure at 21.500 psig (148.237 kPag).

1. Go to Unit [n] > Enable Manual Control. Ensure a checkmark displays to the left of the
menu item. If the analyzer schematic does not display, go to Unit [n] > Show Instrument
Schematic.

2. On the schematic, right-click the Expansion and Vent valves and selectOpen for both. Then
open the Fill valve.

3. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure,
whichever is higher, is shown on the regulator display. Tank pressure should be at least 200
psi above regulator pressure.

4. On the schematic, close the Fill valve, then increase the regulator pressure by 2.0 psig
(13.8 kPag).

5. Allow the pressure in the pycnometer to drop below 2.0 psig, then close the Expansion and
Vent valves.
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SET REGULATOR PRESSURE WITH THE KEYPAD
The Purge fill pressure and cycle fill pressure are specified using Setup > Analysis Parameters.
Set the regulator pressure at the higher of the two (plus 2.0 psig). For example; if the purge fill
pressure is specified as 19.500 psig and the cycle fill pressure as 19.000 psig, then set the
regulator pressure at 21.500 psig.

1. Press Alt + 1 to enter Manual mode.
2. Press 8 (EXPAND) and 9 (VENT) to open the expansion and vent valves; the display will

show: X - O - O
3. Press 7 (FILL) to open the fill valve; the display will show:O - O - O
4. Adjust the regulator pressure control knob until the Purge fill or Cycle fill pressure,

whichever is higher, is shown on the regulator display.
5. Press 7 to close the Fill valve, then increase the regulator valve by 2.0 psig. The display will

show: X - O - O.
6. Allow the pressure in the pycnometer to drop below 2.0 psig, then press 8 and 9 to close the

Expansion and Vent valves. The display will show: X - X - X
7. Press SAVE to return to the Reload prompt.

Regulator Pressure
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12 Maintenance and Troubleshooting

RECOVER FROM A POWER FAILURE
Setup parameters and collected data are recorded by the pycnometer in case of a power failure.
These settings will be available when power is restored. If an automatic operation was in progress
when the power failure occurred, it will be canceled when the pycnometer restarts.

Even though the pycnometer saves data during a power failure, any operation should
be restarted to ensure complete results.

RESET THE PYCNOMETER

Use these instructions for keypad installations only. If a computer is attached to the
module, skip this section. All setup functions will be done in the analysis software.

There are two ways to reset the Pycnometer.

n Hold the .(decimal) key on the keypad during power ON. This erases data and setup para-
meters except for printer and network settings.

n Hold 5 on keypad during power ON. This resets setup parameters, as well as printers and net-
work settings.
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POWER INSTRUMENT ON AND OFF

DO NOT connect or disconnect cables when the instrument is powered ON.

Do not power off the analyzer while initialization is in progress. Doing so may damage
the instrument.

It is important that a constant temperature be maintained inside the unit because a
change in temperature could alter analysis results. We recommend that the pycno-
meter remain powered on at all times to maintain thermal stability.

When the analyzer is powered on, after a few seconds, the system vents automatically and the
green indicator light on the front panel illuminates. Allow approximately 30 minutes for the
analyzer to warm before performing analyses. For analyses that require very precise results, allow
the analyzer to warm a minimum of two hours. If running the analyzer with a computer:

Power ON the equipment in the following order:

If running the analyzer with a computer:

1. Computer
2. Monitor
3. Printer
4. Analyzer

If running the analyzer without a computer:

1. Analyzer

Power Instrument On and Off

AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022 12 - 19



12 Maintenance and Troubleshooting

Power OFF the equipment in the following order:

If running the analyzer with a computer:

1. Analyzer. Allow any analyses in progress to complete prior to powering off.
2. Exit the analysis program. Failure to do so could result in loss of data.
3. Computer.
4. Monitor.
5. Printer.

If running the analyzer without a computer:

1. Allow any analyses in progress to complete prior to powering off the analyzer.
2. Printer.
3. Analyzer.

SERVICE TEST MODE

Options > Service Test Mode

Service Test Mode is a password protected option used to perform certain service tests with the
assistance of a trained Micromeritics Service Representative. This password is supplied by your
Micromeritics Service Representative.

If a menu item is grayed out, it is usually an indication that Service Test Mode is required.

To exit Service Test Mode, go toOptions > Service Test Mode and deselect the Service Test
Mode option or close the application.

PARTS AND ACCESSORIES
Parts and accessories are located on the Micromeritics web page.
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13 TEC MODULE

This AccuPyc system has been modified to provide temperature control from 15 to 36 °C. The
system uses a thermoelectric control (TEC) system to heat or cool the AccuPyc. The temperature
is controlled using a digital temperature controller and a separate power system from the
AccuPyc.

It is suggested that the TEC system be installed first, to allow time for temperature to stabilize at
the desired temperature, while the AccuPyc is being installed.

SET THE TEC TEMPERATURE
1. Power on the TECmodule. The power switch is located near the power inlet.

The digital display of the temperature controller will show a test message while it starts up.
When the test message stops flashing, the current temperature displays. If the current
temperature and a message such as ErAt displays, press the P (Program) key on the front
panel of the controller. The ErAtmessage should stop and only the current temperature will
display.

A. Program keys
B. Up and down keys

2. Press P. SP 1 displays followed by the current setpoint (SP 1). Use the Up or Down key to
set the temperature.

3. Press P to accept the temperature. The controller will now start heating or cooling to
achieve the setpoint

The TECmodule uses a fan to remove heat. The fan is located on the underside of
the instrument. The fan pulls air into the instrument and the air is exhausted through
ventilation slots on the rear panel. The exhaust slots must remain unobstructed.

Do not allow papers or other debris to be pulled across the fan as this will stop the
necessary air flow. The TEC system will be unable to control temperature, and may
become damaged.

13 TECModule
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13 TECModule

OPERATE THE TEC MODULE

When the TEC controller shows the correct temperature, there may be a small difference between
the temperature on the TEC unit and the AccuPyc display because two different sensors are being
used. The AccuPyc sensor and electronics are calibrated together to compensate for any
component differences between the sensor and the circuit board components. Micromeritics
considers the AccuPyc temperature display to be a more accurate reflection of the sample
temperature than the reading from the controller. The controller and the sensor used with the
controller cannot be calibrated.

The TEC controller may be adjusted to compensate for the small difference. If the AccuPyc
temperature is a little high, then reduce the setpoint of the TEC controller by the difference. Wait
for stabilization. Re-adjustment may need to be repeated until the correct AccuPyc temperature is
achieved.

The AccuPyc volume must be calibrated at the analysis temperature. Perform the volume
calibration in the normal way until it is time to insert the reference volume (sphere or spheres).
After installing the reference volume, wait at least 20 minutes to allow the reference volume to
achieve the same temperature as the AccuPyc. Then continue as normal.

When it is necessary to perform AccuPyc tests at a different temperature, re-calibrate the system
volume at the new temperature.

VOLUME CHANGE WITH TEMPERATURE FOR THE 10 CM3 ACCUPYC

The reference spheres supplied with the 10 cm3 AccuPyc are made from tungsten carbide. They
were measured at 20 °C. The spheres will change volume with temperature. The change is very
small and is shown in the following table. Every sphere is a slightly different size, and so the table
provides the factor to be used if the value used during calibration needs to be adjusted. Multiply
the volume provided with the reference spheres by the value in the right column.

Temperature (°C) Typical Volume
(cm3), two balls

Factor

15 6.37125 0.99991

20 6.37182 1.00000

25 6.37238 1.00009

30 6.37295 1.00018

35 6.37351 1.00027

For example, if the ball is 6.37182 cm3 at 20 °C but run at 50 °C, multiply the Volume × the factor
in the table.

6.37182 cm3 x 1.00053 = 6.37520 cm3
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VOLUME CHANGE WITH TEMPERATURE FOR THE 100 CM3 ACCUPYC

The stainless steel calibration standard (ball) supplied with the 100 cm3 AccuPyc is made from
440 grade stainless steel. It was measured at 20 °C. Its volume will be higher when heated above
20 °C. The following table uses the coefficient of thermal expansion of 440 grade stainless steel
(0.0000101 m/m/degree C change) to provide the volume of the sphere at various temperatures.

Every ball is a slightly different size therefore the table provides the factor to be used if the value
used during calibration needs to be adjusted. Multiply the volume provided with the reference
sphere by the value in the right column.

Temperature (°C) Typical Volume (cm3) Factor
15 51.089712 0.99995

20 51.092292 1.000000

25 51.094872 1.000051

30 51.097452 1.000101

35 51.100032 1.000152

For example, if the ball is 51.092292 cm3 at 20 °C but run at 50 °C, multiply the Volume × the
Factor in the table.

51.092292 × 1.000303 = 51.107773

Volume Change with Temperature for the 100 cm3
AccuPyc
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13 TECModule

ASPHALT DENSITY MEASUREMENT

Samples can be analyzed in disposable cups. Any difference in the mass of the cups used for
calibration and analysis will be corrected for in the reported quantities. Performing an asphalt
density measurement requires disposable sample cups.

Steps 1-9 do not need to be repeated for subsequent analyses.

1. Set the instrument temperature and allow 12 hours for equilibration.
2. Go toOptions > Option Presentation. Select Show Cup Properties. Verify that a check-

mark displays to the left.
3. Label each disposable cup with a permanent marker and record its mass.
4. Place a disposable cup in the 3.3 cm3 insert and position the insert in the sample chamber.
5. Go to Unit [n] > Calibration > Calibrate Volume.

a. Enter the mass of the cup in the Cup mass field.
b. Enter the volume of the reference sphere in the Volume of calibration standard field.
c. Select the correct chamber insert.
d. SelectMeasured.
e. Click Start.

6. Insert the reference sphere when prompted and resume the calibration.
7. When the calibration is complete, remove the cup and reference sphere.
8. Prepare a sample in a different disposable cup and place it in the sample chamber.
9. Create a sample file for the analysis.
10. Go to Unit [n] > Sample Analysis and select the sample file created in the previous step.
11. Enter the mass of the cup in the Cup mass field.
12. Select the chamber insert that was used for calibration.
13. Click Start.
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14 TEMPERATURE-CONTROLLED ACCUPYC
A temperature controlled AccuPyc must be connected to a circulating bath (not provided by
Micromeritics). Refer to the manufacturer operator manual for circulating bath operating
instructions.

ATTACH A CIRCULATING BATH
The rear panel of the temperature-controlled AccuPyc contains connections for a circulating bath.
Provided in the accessory kit are two hose fittings and a four foot length of tubing.

1. Power off the controlling unit.
2. Remove the plugs from the In port and theOut port.

A. Circulating bath IN port
B. Circulating bath OUT port

3. Insert the provided hose fittings into each connector.
4. Cut the piece of 4 ft. tubing into two equal pieces of 2 feet each.
5. Install the tubing on the In andOut connectors.
6. Install the other end of theOut tubing to the Inlet connection of the bath circulator.
7. Install the other end of the In tubing to theOutlet connection of the bath circulator.
8. Set the temperature using the appropriate controls on the bath circulator.

14 Temperature-Controlled AccuPyc
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14 Temperature-Controlled AccuPyc

ADD ANALYSIS MODULES TO A TEMPERATURE CONTROLLED
MODULE

If using the Windows version of the AccuPyc II, exit the application before powering
off the analyzer.

1. Power OFF the controlling unit.
2. Connect the circulating bath. See Attach a Circulating Bath on the previous page.
3. Connect one end of the module connector cable (provided in the analysis module accessor-

ies kit) to the connector labeledModule Connection on the rear panel of the control mod-
ule.

4. Connect the other end of the module connector cable to the lower connector labeledMod-
ule Connector on the rear panel of the analysis module.

A. Circulating bath IN port
B. Circulating bath OUT port

Control module Analysis module

5. Power ON the analyzer. If using the Windows version of the AccuPyc II, start the applic-
ation.

6. Calibrate the analysis module using the calibration kit shipped with the system. See About
Calibration on page 10 - 1.
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15 MULTIVOLUME INSERT OPTION

The MultiVolume Insert option provides analysis of samples using smaller-sized sample
chambers.

Wear latex gloves when handling inserts and sample cups. Oils from skin may con-
taminate the surface and affect analysis results. See Handling System Components
on page 11 - 5.

Equipment Description
AccuPyc 1 cm3 Includes a 0.1 cm3 insert / sample cup combination.

AccuPyc 10 cm3 Includes 1 and 3.5 cm3 inserts with corresponding sample cups and
appropriate calibration standards. Fritted filter lids are included for
both inserts.

AccuPyc 100 cm3 Includes 10 and 35 cm3 inserts with corresponding sample cups and
appropriate calibration standards. A fritted filter lid, which prevents
the escape of sample particles under rapid gas flow, is included for
the 10 cm3 insert.

AccuPyc 2000 cm3 Includes 650 and 1300 cm3 cups, supporting inserts and calibration
standards. A tool is also included to allow removal of the supporting
inserts.

An insert changes the size of the sample chamber and requires its own sample cup. All inserts are
shipped with appropriate cups, with the exception of the 0.1 cm3 insert for the 1 cm3 unit. Because
of its size, the sample cup for the 0.1 cm3 insert is built-in. The appearance of the inserts and cups
varies.

n The fritted filter caps for the 1 cm3 and 3.5 cm3 inserts fit on top of the insert.
n The cap for the 10 cm3 insert (shown in image) fits on the sample cup.

15 MultiVolume Insert Option
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15 MultiVolume Insert Option

This example shows a 10 cm3 cup and insert.

A. Fritted filter
B. Sample cup
C. Insert

The inserts for the 2000 cm3 systems are installed and removed with a special tool.

A. Tool
B. Insert
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INSTALL AND REMOVE INSERTS AND SAMPLE CUPS

0.1 CM3 INSERT

The MultiVolume kit contains a special tool required to install the 0.1 cm3 inserts. The sample cup
is built into the 0.1 cm3 insert.

1 CM3 INSERT

The MultiVolume kit contains a special tool required to install the 1 cm3 inserts.

To Install the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side
facing upward.

Contamination from airborne particles can occur rapidly. The chamber cap should be
left off the sample chamber for as little time as possible.

2. Place the insert into the sample chamber.
3. Use the handling tool to grasp the cup for placement in the insert. After placing the sample

into the sample cup, insert the tip of the tool into the cup and press down firmly. The hand-
ling tool features an O-ring to grip the inside surface of the sample cup.

O-ring

4. Place the cup into the insert, then tilt the tool to one side and remove it from the sample cup.

15 MultiVolume Insert Option
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15 MultiVolume Insert Option

5. If using a fritted filter cap, place it onto the top of the insert.
6. Replace the sample chamber cap.

To Remove the Insert

1. Remove the sample chamber cap and place on a clean work surface with the greased side
facing upward.

2. Remove the fritted filter cap (if used).
3. Insert the handling tool into the sample cup until the sample cup is gripped by the O-ring.
4. Lift the sample cup out of the insert.
5. Pull the insert from the sample chamber.
6. Replace the sample chamber cap.

10, 3.5, AND 35 CM3 INSERTS

Remove the chamber cap and place the insert into the sample chamber. The insert should fit
snugly in the chamber. Place the appropriate sample cup into the well of the insert.

Do not force the insert or cup into the openings. This may damage the instrument,
insert, or sample cup.

Install the fritted filter cap (if used) before closing the sample chamber. A fritted filter cap is used to
constrict gas flow and is included with some inserts. The fritted filter cap for the 10 cm3 insert fits
on the top of the sample cup. The fritted filter caps for the 1 and 3.5 cm3 inserts fit on the top of the
insert. Fritted filter caps are not available for the 0.1 and 35 cm3 inserts.
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CALIBRATE INSERT
An insert must be calibrated and its operation verified. Appropriate calibration standards are
included in the MultiVolume kits. For example, a 100 cm3 capacity AccuPyc with a 10 cm3 insert
must be calibrated with the 10 cm3 insert, cup, and calibration standards.

0.1 CM3 INSERT
Because of the size of the 0.1 cm3 insert, its calibration is performed in a different manner from
that of other inserts.

If the 1 cm3 pycnometer has not been calibrated recently, perform a calibration before
calibrating the 0.1 cm3 insert.

1. Remove the sample chamber cap and place on a clean work surface with the greased side
facing upward.

2. Place the insert into the sample chamber (the sample cup is built into the insert). Replace
the chamber cap.

3. Press Alt + 4 to access the Analyze function. Press ENTER until the Chamber Insert
prompt is displayed. Ensure that None is displayed.

4. Press ENTER to display the Analyze prompt. Press ENTER to begin the calibration.
5. After the calibration is complete, the Reload prompt is displayed.
6. Press CHOICE until the average measured volume is displayed. Record this value.
7. Press Alt + 2 to access Setup.
8. Press CHOICE until Calibration Data is displayed.
9. Press ENTER to display the Chamber Insert prompt.
10. Ensure that None is selected, then press ENTER to display the Cell Volume prompt.
11. Subtract the average volume of the 0.1 cm3 insert / cup (recorded in Step 6) from the cell

volume displayed in the prompt. Record this value.
12. Press ENTER to display the Expansion Volume prompt.
13. Record the value displayed for the expansion volume, then press ENTER to return to the

Calibration Data prompt.
14. Press ENTER. The Chamber Insert prompt is displayed.
15. Press CHOICE until 0.1 cm3 is displayed, then press ENTER to display the Cell Volume

prompt. Enter the value recorded in Step 11.
16. Press ENTER to display the Expansion Volume prompt. Enter the value recorded in Step

12.
17. Press SAVE to save the information and return to the Reload prompt.

The pycnometer is now ready for analyses using the 0.1 cm3 insert / cup.

15 MultiVolume Insert Option
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15 MultiVolume Insert Option

1, 10, 3.5, 35, 650, AND 1300 CM3 INSERTS
1. Remove the sample chamber cap and place on a clean work surface with the greased side

facing upward.
2. Place the insert and sample cup into the sample chamber. Replace the chamber cap.
3. Calibrate the insert. See About Calibration on page 10 - 1.
4. See Verify Operation on page 10 - 11.

OPERATING PARAMETERS USING THE KEYPAD
To operate using inserts, access the Chamber Insert prompt to select the appropriate
MultiVolume insert.

1. Press Alt + 2 to access the Setup function.
2. Press CHOICE until Report Options is displayed, then press ENTER.
3. Continue pressing ENTER until the Request Insert prompt is displayed.
4. Press CHOICE until Yes is displayed, then press ENTER.

5. Press SAVE to save the changes and return to the Reload prompt.
A Chamber Insert prompt will display during all normal operating procedures. For example, a
Chamber Insert prompt will display when starting a calibration or analysis.
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16 MULTIGAS OPTION

The Multigas option enables the AccuPyc to use up to four different gases. The Multigas assembly
consists of:

n Valve assembly and two retaining screws
n Gas entrance tubing for connection from the analyzer to the valve assembly
n Gas supply tubing for four gases

INSTALL THE MULTIGAS ASSEMBLY

A. Retaining screws
B. Ferrules
C. Swage nut

If a gas is attached to the gas inlet on the rear panel of the analyzer, close the gas cyl-
inder valve and remove the inlet tubing from the analyzer before installing the multigas
assembly. The gas can then be attached to one of the inlet valves on the assembly.

1. Remove the two retaining screws on the rear panel of the AccuPyc.
2. Position the valve assembly against the rear panel so that the retaining screw holes on the

valve assembly align with those on the rear panel of the analyzer.
3. Attach the valve assembly to the rear panel using the two screws included in the multigas

kit.
4. Carefully cut and remove the cable ties holding the gas entrance tubing in position and

remove the ties.
5. Remove the protective caps from the ends of the gas entrance tubing, then remove the fer-

rules from the upper end of the tubing.
6. Remove the nut from the center port and slide it onto the end of the gas entrance tubing,

then replace the front and back ferrules.
7. Insert the tubing into the center port of the multigas assembly. Use the nut to secure the

tubing to the assembly.
8. Insert the other end of the tubing into the gas inlet. Use the self contained swage nut to

secure the tubing to the inlet.

16 Multigas Option
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16 Multigas Option

CONNECT GASES

1. Connect one end of the gas supply tubing to the gas supply.
2. Insert the other end of the tubing into one of the valve inlets on the multigas assembly.
3. The faceplate of the valve assembly contains four sections; one for each gas inlet on the

assembly. Write the name of the gas in the applicable section.

Write the name of the gas connected to
the inlet

SELECT GASES

After installing the gases, use the knob to select the gas. Purge the gas lines when changing
gases.

Turn the knob to select the gas
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A ADVANCED REPORTS - PYTHON MODULE

In a 21CFR11 environment, the Advanced reports feature is applicable to members
of the Developer group only.

The mic Python module is automatically imported when running a user supplied script. The
module provides access to primary and overlay data and provides support for summary, tabular,
and graphical reports.

n Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with themic.summary call.

n Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with themic.table call.

n Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with themic.graph call.

Calls for accessing the sample file data can be found in theMic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

A Advanced Reports - Python Module
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A Advanced Reports - Python Module

ADVANCED REPORT OPTIONS

AccuPyc 1345 specific example scripts are located in the scripts directory which doc-
ument the usage of 1345 related python calls.

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. SeeMicModule Python Calls on page A - 15 for an
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.
2. Open a sample file with a Complete status.
3. Select Advanced in the view selector drop-down list at the bottom of the window to return to

the tabbed view.
4. On the Report Options tab, select Advanced in the Selected Reports list box, then click

Edit.
5. On the Advanced Report Options window, click Add in the Available Scripts group box to

locate and select the Python script. Repeat for each script to be added.

6. In the Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. On the Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.
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Selections Description
Advanced Report 1
through 5
[drop-down box]

Use the drop-down lists to select currently-defined functions used to
define the report calculations and output.

Available Scripts
[group box]

Lists the available reports and provides the option to add, replace,
edit, or remove reports.

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 3 - 2.

Advanced Reports

GRAPHIC REPORTS

ADD A CURVE

This script adds a curve to the last created graphical report:

1 mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',

2               marker='a', graphtype='both', interpolation='akima'):

3

4 Keyword arguments:

5

6   name      --- the curve name

7   x         --- list of x values; must be a list of floats

8 (or convertible) and the same length as y

9   y         --- list of y values; must be a list of floats

10 (or convertible) and the same length as x

11   yyaxis    --- place this curve on the yy-axis if True

12                 otherwise place on the y-axis (default = False)

13   color     --- RGB color as an HTML hex string (e.g., '#4169e1')

14 or a three-element list or tuple (e.g., [65,105,225]);

15 if None, color is automatically selected (default = None)

16   linestyle --- line style; (default = '-')

17 '-'        : solid

Graphic Reports
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A Advanced Reports - Python Module

18 '--'       : dash

19 '.'        : dot

20 '-.'       : dash dot

21 '-..'      : dash dot dot

22   marker    --- marker shape; (default = 'a')

23 '+'        : plus

24 'o' or '0' : circle

25 'x'        : cross

26 '^'        : up triangle

27 'v'        : down triangle

28 's'        : square

29 'd'        : diamond

30 '8'        : hourglass

31 '~'        : horizontal hourglass

32 '' or None : no marker

33 'a'        : automatically selected

34   graphtype --- graph type; (default = 'both')

35 'curve' or 'c' : curve

36 'points' or 'p' : points

37 'both' or 'b' : curve-and-points

38 'hist' or 'h' : histogram

39   interpolation -- linear or akima spline interpolation (default='akima')

40 'akima' use akima spline

41 'linear' use linear interpolation

ADD A CURVE USING THE SECOND Y-AXIS

This script adds a curve to the last created graphical report using the second y-axis:

1 mic.graph.addyy(name, xx, yy):

2
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3 Add a curve to the last created graphical report using the second

4 y-axis. The arguments to this call are the same as to mic.graph.add.

Add a Curve Using the Second Y-Axis
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CREATE A NEW GRAPHICAL REPORT

1 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis',

2           yylabel='YY axis',

3           xlinear=True, ylinear=True, yylinear=True,

4           xinvert=False, yinvert=False, yyinvert=False,

5           xrange=None, yrange=None, yyrange=None, xbars_id=''):

6

7 Keyword arguments:

8

9   title    --- the graphical report title (default = 'User Graph')

10   xlabel   --- x-axis label (default = 'X axis')

11   ylabel   --- y-axis label (default = 'Y axis')

12   yylabel  --- yy-axis label (default = 'YY axis')

13   xlinear  --- x-axis linear scale; if false, use log scale

14 (default = True)

15   ylinear  --- y-axis linear scale; if false, use log scale

16 (default = True)

17   yylinear --- yy-axis linear scale; if false, use log scale

18 (default = True)

19   xinvert  --- Invert x-axis if true (default = False)

20   yinvert  --- Invert y-axis if true (default = False)

21   yyinvert --- Invert yy-axis if true (default = False)

22   xrange   --- None, or two values giving the min and max

23                range of the axis.

24   yrange   --- None, or two values giving the min and max

25                range of the axis.

26   yyrange  --- None, or two values giving the min and max

27                range of the axis.

28   xbars_id --- None, or the id of an xbar control created

29                via the mic.control() object
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SCRIPTS

RUN A SCRIPT

1. Open a sample file with a Complete file status.
2. Select Advanced in the view selector drop-down list at the bottom of the window.
3. Select the Report Options tab.
4. Highlight Advanced in the Selected Reports list box, then click Edit.
5. On the Advanced Report Options window, click Add.
6. Locate and select one or more python scripts then click Select. The selected scripts

become a part of the drop-down list in the Available Scripts section of the Advanced Report
Options window.

7. In the Select Reports section, select up to five Advanced reports in the drop-down lists.
8. ClickOK.
9. Click Preview on the Report Options tab to view all reports selected in the previous window.

REMOVE A SCRIPT

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.

Scripts
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EDIT A SCRIPT

Selections Description
Add [button] Adds one or more scripts to the Available Scripts box. The added

scripts then become available as options in the Selected Reports
section.

Edit [button] Edits the script stored within the application but does not affect the
original .py text file.

Remove [button] Removes the script from the Available Scripts box but does not affect
original .py text file.

Replace [button] Replaces the contents of the selected script however, the script
name remains the same.
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PYTHON REPORTS

GRAPHIC REPORT

This script is an example of the mic module producing a graph with two curves:

1 import mic

2 import numpy as np

3

4 mic.graph( 'My Graph', 'X', 'F(X)' )

5 myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ] )

6 mic.graph.add( 'X2', myx, myx*myx, marker='o' )

7 mic.graph.add( 'sin(X)', myx, np.sin(myx), marker='^' )

The results are:

Python Reports
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SUMMARY REPORT

This script produces a summary report with two summaries:

1 import mic

2 import numpy as np

3

4 mic.summary( "My Summaries" )

5 mic.summary.add( "Summary A",

6 ["Label 1:", "Label 2:", "Label 3:"],

7 ["val1", "val2", "val3"] )

8 mic.summary.add( "Summary B",

9 ["Label 4:", "Label 5:", "Label 6:"],

10 ["val4", "val5", "val6"] )

The result is:
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TABULAR REPORT

If more than one column is required, the callmic.table is employed. This script produces a tabular
report consisting of two tables.

This script uses the Python package numpy and c-style formatting of the numerical
values.

11 import mic

12 import numpy as np

13

14 mic.table( "My Tables" )

15 mic.table.addtable( "My Set A" )

16 mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )

17 mic.table.addcolumn( "Y", ["0.5", "1.0", "1.5"] )

18 x1 = 0.2

19 x2 = 0.5

20 x3 = 3.14159/2

21 mic.table.addtable( "My Set B" )

22 mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),

23 '{:8.3f}'.format(x2),

24 '{:8.3f}'.format(x3)] )

25 mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),

26 '{:8.3f}'.format(np.sin(x2)),

27 '{:8.3f}'.format(np.sin(x3))] )

28 mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),

29 '{:8.3f}'.format(np.cos(x2)),

30 '{:8.3f}'.format(np.cos(x3))] )

Tabular Report
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The result is:
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ENABLE THE USE OF OVERLAY DATA
1. On the Report Options tab, clickOverlays.
2. On the Plot Overlay Sample Selection window, to move a file from the Available Files list

box to the Selected Files list box, either double-click a file name in the Available Files list
box or click one or more files in the Available Files list box then click Add.

3. ClickOK.
4. On the Report Options tab, highlight Advanced in the Selected Reports list box.
5. Select theOverlay samples checkbox to the right of the selected report.
6. ClickOK.
7. Run the script using the instructions found in Scripts on page A - 7.

Enable the Use of Overlay Data

AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022 A - 13



A Advanced Reports - Python Module

A - 14 AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022



MICMODULE PYTHON CALLS

TABLES

Available Mic Python calls for tables:

n Create a new tabular report
n Add a column
n Add a table

Add a Table

This script adds a table to the last created tabular report:

1 mic.table.addtable( name )

2

3 Keyword arguments:

4

5   name --- the table name

Add a Column

This script adds a column to the last created table:

1 mic.table.addcolumn(header, values, align='r'):

2

3 Keyword arguments:

4

5   header --- column header; must be a string (or convertible)

6   values --- column values; must be a list of strings (or convertible)

7   align  --- column alignment; 'r', 'l', 'c' for right, left, and center jus-
tified

MicModule Python Calls
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Create a New Tabular Report

1 mic.table( title='User Table' )

2

3 Keyword arguments:

4

5   title --- the tabular report title (default = 'User Table')
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SUMMARY REPORTS

Add a Summary Section

This script adds a summary section to the last created summary report:

1 mic.summary.add(name, labels, values):

2

3 Keyword arguments:

4

5   name   --- summary section name

6   labels --- column of labels; must be a list of strings

7 (or convertible) and the same length as values

8   values --- column of values; must be a list of strings

9 (or convertible) and the same length as labels

Create a New Summary Report

1 mic.summary( title='User Summary' )

2

3 Keyword arguments:

4

5   title --- the summary title

Summary Reports
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GRAPHIC REPORTS

Add a Curve

This script adds a curve to the last created graphical report:

1 mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',

2               marker='a', graphtype='both', interpolation='akima'):

3

4 Keyword arguments:

5

6   name      --- the curve name

7   x         --- list of x values; must be a list of floats

8 (or convertible) and the same length as y

9   y         --- list of y values; must be a list of floats

10 (or convertible) and the same length as x

11   yyaxis    --- place this curve on the yy-axis if True

12                 otherwise place on the y-axis (default = False)

13   color     --- RGB color as an HTML hex string (e.g., '#4169e1')

14 or a three-element list or tuple (e.g., [65,105,225]);

15 if None, color is automatically selected (default = None)

16   linestyle --- line style; (default = '-')

17 '-'        : solid

18 '--'       : dash

19 '.'        : dot

20 '-.'       : dash dot

21 '-..'      : dash dot dot

22   marker    --- marker shape; (default = 'a')

23 '+'        : plus

24 'o' or '0' : circle

25 'x'        : cross

26 '^'        : up triangle

27 'v'        : down triangle
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28 's'        : square

29 'd'        : diamond

30 '8'        : hourglass

31 '~'        : horizontal hourglass

32 '' or None : no marker

33 'a'        : automatically selected

34   graphtype --- graph type; (default = 'both')

35 'curve' or 'c' : curve

36 'points' or 'p' : points

37 'both' or 'b' : curve-and-points

38 'hist' or 'h' : histogram

39   interpolation -- linear or akima spline interpolation (default='akima')

40 'akima' use akima spline

41 'linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

1 mic.graph.addyy(name, xx, yy):

2

3 Add a curve to the last created graphical report using the second

4 y-axis. The arguments to this call are the same as to mic.graph.add.

Graphic Reports
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Create a New Graphical Report

1 mic.graph(title='User Graph', xlabel='X axis', ylabel='Y axis',

2           yylabel='YY axis',

3           xlinear=True, ylinear=True, yylinear=True,

4           xinvert=False, yinvert=False, yyinvert=False,

5           xrange=None, yrange=None, yyrange=None, xbars_id=''):

6

7 Keyword arguments:

8

9   title    --- the graphical report title (default = 'User Graph')

10   xlabel   --- x-axis label (default = 'X axis')

11   ylabel   --- y-axis label (default = 'Y axis')

12   yylabel  --- yy-axis label (default = 'YY axis')

13   xlinear  --- x-axis linear scale; if false, use log scale

14 (default = True)

15   ylinear  --- y-axis linear scale; if false, use log scale

16 (default = True)

17   yylinear --- yy-axis linear scale; if false, use log scale

18 (default = True)

19   xinvert  --- Invert x-axis if true (default = False)

20   yinvert  --- Invert y-axis if true (default = False)

21   yyinvert --- Invert yy-axis if true (default = False)

22   xrange   --- None, or two values giving the min and max

23                range of the axis.

24   yrange   --- None, or two values giving the min and max

25                range of the axis.

26   yyrange  --- None, or two values giving the min and max

27                range of the axis.

28   xbars_id --- None, or the id of an xbar control created

29                via the mic.control() object
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GET SAMPLE INFORMATION ITEM

1 mic.sample_information( item, sample_number = 0 ):

2

3 Keyword arguments:

4

5   item          --- string identifying the item to be returned.

6                     For example; 'sample mass', or 'sample description'

7                     The default is an empty string for which the return

8                     value is a list of all available keywords

9

10   sample_number --- Sample to retrieve

11 0           : current sample file (default)

12 1 through 8 : corresponding overlay sample file

13

14 Usage:

15

16   all_keywords = sample_information()

17   mass         = sample_information('sample mass')

18   mass         = sample_information('sample mass',0)

Get Sample Information Item
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B EXPORTED DATA EXAMPLE
This exported data has been truncated for this manual.

Sample Information

                     Sample Information

                    Method:    Default                      

                    Sample:    Pt-Alumina                   

                  Operator:    ELV                          

                 Submitter:                                 

                 Mass type:    Entered                      

               Sample mass:    6.3067 g                     

                   Density:    1.000 g/cm³                  

              Type of data:    Automatically collected      

           Instrument type:    1345                         

  Original instrument type:    1345                         

                  Comments:    004/16825/00

Lot SE13378-4  

      Sample Cup Properties                                 

               Description:    Sample Cup Properties        

                  Cup mass:    0.0000 g                     

               Cup density:    2.7000 g/cm³                 

        Material Properties                                 

          Envelope density:    1.0000 g/cm³                 

            Liquid density:    1.0000 g/cm³                 

            Solids density:    1.0000 g/cm³                 

Analysis Conditions

B Exported Data Example
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                  Analysis conditions:

                   Description:    Analysis Conditions  

                  Analysis gas:    Helium               

              Number of purges:    10                   

           Purge fill pressure:    19.500 psig          

              Number of cycles:    10                   

           Cycle fill pressure:    19.500               

                 Equilib. rate:    0.0050 psig/min      

             Use run precision?    No                   

               Analysis method:    Standard             

  Record P1 equilibration data?    No                   

  Record P2 equilibration data?    No                   

Report Options

        Description:    Report Options  

  Show report title:    Yes             

       Show graphic:    Yes             

     Graphic height:    0.250 in        

      Graphic width:    2.000 in        

            Overlay:    None            

                  Reports

                   Combined Report    No   

                    Summary Report    Yes  

          Density and Volume Table    Yes  
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         Pressure and Volume Table    No   

                 Volume vs Cycle #    Yes  

                   Density vs Time    No   

  Total Pore Volume vs Temperature    No   

                Density vs Cycle #    Yes  

                  P1 Equilibration    No   

                  P2 Equilibration    No   

                  Advanced Reports    No   

                    Options Report    No   

                        Sample Log    No   

           Summary Report

               Sample Volume         

                    Average:    Yes  

         Standard Deviation:    Yes  

   Coefficient of Variation:    No   

                  Pass/Fail:    No   

              Sample Density         

                    Average:    Yes  

         Standard Deviation:    Yes  

   Coefficient of Variation:    No   

                  Pass/Fail:    No   

            Specific Gravity         

                    Average:    No   

         Standard Deviation:    No   

   Coefficient of Variation:    No   

                  Pass/Fail:    No   

          Total Pore Volume*         

                    Average:    No   

         Standard Deviation:    No   

   Coefficient of Variation:    No   

B Exported Data Example
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                  Pass/Fail:    No   

  Total Solids Concentration         

                    Average:    No   

         Standard Deviation:    No   

   Coefficient of Variation:    No   

                  Pass/Fail:    No   

           Percent Porosity*         

                    Average:    No   

         Standard Deviation:    No   

   Coefficient of Variation:    No   

                  Pass/Fail:    No   

                 Temperature         

                    Average:    No   

         Standard Deviation:    No   

   Coefficient of Variation:    No   

                  Pass/Fail:    No   

    Density and Volume Table

  Column 1    Cycle Number       

  Column 2    Volume             

  Column 3    Volume Deviation   

  Column 4    Density            

  Column 5    Density Deviation  

  Column 6    Elapsed Time       

  Column 7    Temperature        

             Summary Data

                      Volume:         

                     Average:    Yes  

          Standard Deviation:    Yes  
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    Coefficient of Variation:    No   

                     Density:         

                     Average:    Yes  

          Standard Deviation:    Yes  

    Coefficient of Variation:    No   

            Specific Gravity:         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

          Total Pore Volume*:         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

  Total Solids Concentration:         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

           Percent Porosity*:         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

                 Temperature:         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

B Exported Data Example
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              Volume (60° F):         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

             Density (60° F):         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

    Specific Gravity (60° F):         

                     Average:    No   

          Standard Deviation:    No   

    Coefficient of Variation:    No   

           Volume vs Cycle #

            X Axis:    Cycle Number     

            Y Axis:    Volume           

           Overlay:    Overlay Samples  

      Show Average:    Yes              

    Show Reference:    No               

   Reference Value:    0.0000 cm³       

          Show +/-:    No               

         +/- Value:    3.0 sigma        

        Show Range:    No               

           Minimum:    0.0000 cm³       

           Maximum:    0.0000 cm³       

        Plot Curve:    Yes              

       Plot Points:    Yes              

  Autoscale X Axis:    Yes              
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  Autoscale Y Axis:    Yes              

           Density vs Cycle #

            X Axis:    Cycle Number     

            Y Axis:    Density          

           Overlay:    Overlay Samples  

      Show Average:    Yes              

    Show Reference:    No               

   Reference Value:    0.0000 g/cm³     

          Show +/-:    No               

         +/- Value:    3.0 sigma        

        Show Range:    No               

           Minimum:    0.0000 g/cm³     

           Maximum:    0.0000 g/cm³     

        Plot Curve:    Yes              

       Plot Points:    Yes              

  Autoscale X Axis:    Yes              

  Autoscale Y Axis:    Yes              

Collected Data

    Chamber Insert:    None           

       Cell Volume:    11.743300 cm³  

  Expansion Volume:    8.410800 cm³   

                         Collected Data

  Elapsed       P1           P2                                 

B Exported Data Example
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B Exported Data Example

   Time      Pressure     Pressure      Volume     Temperature  

(mm:ss)     (psig)       (psig)       (cm³)         (°C)      

-----

     9:28    19.540010    10.525300    1.923108      24.898489  

    11:55    19.528679    10.519403    1.922688      24.857891  

    14:20    19.538498    10.524772    1.922529      24.920292  

    16:48    19.540857    10.526293    1.922023      24.972166  

    19:18    19.536482    10.524108    1.921674      24.965399  

    21:47    19.528141    10.519802    1.921295      25.047722  

    24:19    19.540800    10.526590    1.921358      25.095461  

    26:52    19.532545    10.522022    1.921604      25.132675  

    29:14    19.541279    10.527058    1.920935      25.145832  

    31:44    19.541832    10.527386    1.920874      25.202969  
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C SAMPLE VOLUME EQUATION DERIVATION

10, 100, AND 350 CM3 UNITS
The AccuPyc II is a gas displacement pycnometer which measures the volume of solid objects of
irregular or regular shape whether powdered or in one piece. A greatly simplified diagram of the
instrument is shown below.

Sample volume is determined from the known cell and expansion volumes and frommeasured
pressures.

The cell and expansion chamber are initially at ambient pressure and the valve is closed. The cell
is then charged to an elevated pressure.

The ideal gas law gives:

(1)

where

nc = moles of gas in the sample cell
R = the gas constant
T = temperature
Vc = cell volume
Vs = sample volume
Vx = expansion volume
P1 = initial cell pressure

Expansion volume:

(2)

C Sample Volume Equation Derivation
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C Sample Volume Equation Derivation

where

Pa = ambient pressure
nx = moles of gas in the expansion volume

When the valve is opened, the pressure falls to an intermediate value, P2, and mass balance
yields:

(3)

Substituting from equations (1) and (2) into (3):

(4)

or

(5)

then

(6)

Adding and subtracting Pa in the denominator and rearranging gives

(7)

Dividing by (Pa - P2) in both the numerator and denominator

(8)

or

(9)
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Using gauge pressure defined as:

(10)

equation (9) is rewritten as:

(11)

1 CM3 AND 2000 CM3 UNITS
The 1 cm3 and 2000 cm3 pycnometers operate by filling the expansion chamber while the sample
cell remains at ambient pressure. After P1 is equilibrated, the expansion valve opens to allow gas
to expand into the sample chamber and P2 is equilibrated.

For the 1 cm3 and 2000 cm3 pycnometers, equation (1) becomes

and equation (2) becomes

A derivation similar to that above yields the working equation for the 1 cm3 and 2000 cm3

pycnometers

C Sample Volume Equation Derivation
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D TRANSMITTED DATA

Use these instructions for keypad installations only. If a computer is attached to the
module, skip this section. All setup functions will be done in the analysis software.

Analysis and calibration data can be transmitted in a single column or spreadsheet with data in
ASCII delimited format. Units are displayed as:

Type Measurement
Date DD/MM/YY

Time HH:MM:SS

Pressure psig

Temperature °C

Elapsed Time seconds

Data Units

ANALYSIS REPORT

Record
Number

Description Form

1 Version Number 20 characters

2 Serial Number 1 integer

3 Report type = analysis 8 characters

4 Start (reported on one line as ASCII comma delimited
data)

n 4a. Date
n 4b. Time

8 characters (each)

5 Stop (reported on one line as ASCII comma delimited
data)

n 5a. Date
n 5b. Time

8 characters (each)

6 Temperature 1 floating point

Analysis Report - Spreadsheet

D Transmitted Data

AccuPyc II 1345 Operator Manual
134-42851-01 (Rev B) — Sep 2022 D - 1



D Transmitted Data

Record
Number

Description Form

7 Description line 1 20 characters

8 Description line 2 20 characters

9 Sample IDs 20 characters

10 Sample mass 1 floating point

11 Number of purges 1 integer

12 Equilibration rate 1 floating point

13 Chamber Insert:

n 0 = None
n 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

n 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

14 Cell volume 1 floating point

15 Expansion volume 1 floating point

16 Average volume 1 floating point

17 Volume standard deviation 1 floating point

18 Average density 1 floating point

19 Density standard deviation 1 floating point

20 Number of runs 1 integer

21 Run precision

n 0 = Disabled
n 1 = Enabled

1 floating point

22 Percent full scale 1 floating point

23 Carriage return / Line feed

24 Carriage return / Line feed

Analysis Report - Spreadsheet (continued)
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Record
Number

Description Form

25 Carriage return / Line feed

26 Run number and pressure (reported on one line as
ASCII comma delimited data)

26a Run number 1 integer

26b P1 1 floating point

26c P2 1 floating point

26d Include in average calculation

n 0 = Excluded
n 1 = Included

1 integer

26e Elapsed time 1 unsigned integer

26f Volume 1 floating point

26g Volume deviation 1 floating point

26h Density 1 floating point

26i Density deviation 1 floating point

27 Temperature (all temperature data) 1 floating point

Analysis Report - Spreadsheet (continued)
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D Transmitted Data

CALIBRATION REPORT

Record
Number

Description Form

1 Version Number 20 characters

2 Serial Number 1 integer

3 Report type = calibration 11 characters

4 Start (reported on one line as ASCII comma delimited
data)

n 4a. Date
n 4b. Time

8 characters (each)

5 Stop (reported on one line as ASCII comma delimited
data)

n 5a. Date
n 5b. Time

8 characters (each)

6 Temperature 1 floating point

7 Calibration standard size 1 floating point

8 Number of purges 1 integer

9 Equilibration rates 1 floating point

10 Chamber Insert:

n 0 = None
n 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

n 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

11 Average cell volume 1 floating point

12 Cell volume standard deviation 1 floating point

13 Average expansion volume 1 floating point

Calibration Report - Single Column
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Record
Number

Description Form

14 Expansion volume standard deviation 1 floating point

15 Number of runs 1 integer

16 P1 (all P1 data) 1 floating point

17 P2 (all P2 data) 1 floating point

18 P1* (all P1* data) 1 floating point

19 P2* (all P2* data) 1 floating point

20 Include in average calculation

n 0 = Excluded
n 1 = Included

1 integer

Calibration Report - Single Column (continued)
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D Transmitted Data

Record
Number

Description Form

1 Version Number 20 characters

2 Serial Number 1 integer

3 Report type = calibration 11 characters

4 Start (reported on one line as ASCII comma delimited
data)

n 4a. Date
n 4b. Time

8 characters (each)

5 Stop (reported on one line as ASCII comma delimited
data)

n 5a. Date
n 5b. Time

8 characters (each)

6 Temperature 1 floating point

7 Calibration standard size 1 floating point

8 Number of purges 1 integer

9 Equilibration rates 1 floating point

10 Chamber Insert:

n 0 = None
n 1 = 10 cm3 (100 cm3 unit)

1 cm3 (10 cm3 unit)

0.1 cm3 (1 cm3 unit)

n 2 = 35 cm3 (100 cm3 unit)

3.5 cm3 (10 cm3 unit)

1 integer

11 Average cell volume 1 floating point

12 Cell volume standard deviation 1 floating point

13 Average expansion volume 1 floating point

14 Expansion volume standard deviation 1 floating point

15 Number of runs 1 integer

Calibration Report - Spreadsheet
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Record
Number

Description Form

16 Carriage return / Line feed

17 Carriage return / Line feed

18 Carriage return / Line feed

19 Run number and pressure (reported on one line as
ASCII comma delimited data)

19a Run number 1 integer

19b P1 1 floating point

19c P2 1 floating point

19d P1* 1 floating point

19e P2* 1 floating point

19f Include in average calculation

n 0 = Excluded
n 1 = Included

1 integer

19g Cell volume 1 floating point

19h Cell volume deviation 1 floating point

19i Expansion volume 1 floating point

19j Expansion volume deviation 1 floating point

Calibration Report - Spreadsheet (continued)

D Transmitted Data
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